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PIC18FXXX Hands On
Workshop Agenda

PIC18FXXX Hands OnPIC18FXXX Hands On
Workshop AgendaWorkshop Agenda

l PIC18FXXXX architecture, peripherals and special features
l PICmicro product overview including future products
l PIC18FXXXX development tool overview
l Audio Spectrum Analyzer Demo Board design
l Lab 1 - Install MPLAB 6.0, MPLAB ICD 2, MPLAB C18,

Demo Board, Create Project, Compile and Run, Display
Message

l Lab 2 - Develop a traffic light
l Lab 3 - A/D Sampling ISR, Fill A/D sample buffer
l Lab 4 - Apply DFT to A/D sample buffer, scale and display

DFT results.
l Lab 5 - Extra credit- Add Automatic Gain Control
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PIC18FXXX Workshop
Appendix A-D

PIC18FXXX WorkshopPIC18FXXX Workshop
Appendix A-DAppendix A-D

l The following Appendix topics are available
for your reference, but will not be presented
today:
l Appendix A: Optimizing C source code for

compiler efficiency
l Appendix B: PIC18FXXXX Instruction Set,

PIC16/17 migration
l Appendix C: PIC18FXXXX Flash Programming

Tips
l Appendix D: PIC18FXXXX Peripheral

Calculation Spreadsheet
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Microchip Technology Inc.Microchip Technology Inc.Microchip Technology Inc.

Company Overview
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Corporate OverviewCorporate OverviewCorporate Overview

l  Leading semiconductor manufacturer:
l of high-performance, field-programmable

8-bit & 16-bit RISC Microcontrollers
l of Analog & Interface products
l of related Memory products
l for high-volume embedded control

applications
l  $572 million in product sales in FY02
l  More than 3,000 employees
l  Headquartered near
      Phoenix in Chandler, AZ

 “The Silicon Desert”
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1989  Pioneered field-programmable MCU: PIC16C5X family
1990  Shipped 1 millionth OTP PICmicro® device
1991  Introduced MPLAB® IDE -- the world’s first Windows 3.0

based development system
1992  Offered ROM program memory to PICmicro customer

base
1994  Introduced Enhanced FLASH PICmicro MCUs
1996  Introduced the world’s first 8-pin microcontrollers

 Ranked #5 in 8-bit MCU market share
1997  Achieved #2 ranking in 8-bit MCU market share
1999  Introduced PIC18CXXX enhanced core architecture

 Shipped 1 billionth PICmicro MCU
2000  Announced comprehensive FLASH PICmicro product

roadmap
2001     Shipped 200,000th development system
2002 Shipped 2 billionth PICmicro MCU

History of the PICmicro®

Microcontroller
History of the PICmicroHistory of the PICmicro®®

MicrocontrollerMicrocontroller
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Worldwide Manufacturing LocationsWorldwide Manufacturing Locations

Arizona Corp. HQ

Fab 1
270 K sq feet

Fab 2
178 K sq feet

Bangkok
Assembly &
Test Facility
190K sq feet

Shanghai
Assembly &

Test

80 K sq feet

Washington

Fab 3
710K sq feet
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RF
Xmit/receive

IR
Communication

Power
Drivers

Motors
Relays

Print-heads

Digital
Peripherals

PWM
Real Time Clock

Encryption
(KEELOQ®)

Speech
Co-Processing

LED
Drivers

VF
Drivers

LCD
Drivers

AmplifiersSensors Filters

SRAM

A/D

Microcontrollers D/A

Precision
Voltage

Reference

Bus 
Communication 
- CAN bus  
- USB
- I2C™
- SPI™
- RS422/423

Power
Management
- Regulators
- Supervisory

Power

High Voltage
I/O’s

Telecom
DTMF
Codec

Serial NV
Memory

Digital Pot

Transceivers
- RS232/485
-  CAN bus
-  USB

Existing PICmicro® MCU Core
and Peripheral Blocks

Existing PICmicroExisting PICmicro®® MCU Core MCU Core
and Peripheral Blocksand Peripheral Blocks
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PIC17CXXX
High-Performance
Family

PIC17CXXX
High-Performance
Family

PIC16CXX
Mid-Range Family
PIC16CXXPIC16CXX
Mid-Range FamilyMid-Range Family

PIC12CXXX
8-Pin Family
PIC12CXXX
8-Pin Family

8-Bit8-Bit

16-Bit16-Bit

4-Bit4-Bit

32-Bit32-Bit

PIC16C5X
Baseline Family
PIC16C5X
Baseline Family

PIC18CXXX
Enhanced MCU Core
PIC18CXXX
Enhanced MCU Core

Microcontroller Market PyramidMicrocontroller Market PyramidMicrocontroller Market Pyramid
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44

Compute Intensive  

Large Memory 22Tech
 Drive

r
111

2.0 to 5.5 volts - 0.4 micron
       1.8 to 3.6 volts - 0.18 micron

H.V. Foundry

33

PICmicro® Strategic DirectionsPICmicro® Strategic Directions
New Process DevelopmentNew Process Development

      Advanced Analog 

High Density MemoryHigh Density Memory
ROMless,ROMless,

FLASHFLASH

ComputeCompute
IntensiveIntensive

PIC18F452/442/252/242
dsPIC30F

Adv. MixedAdv. Mixed
            Signal,            Signal,

HV or HIHV or HI
PIC16C773/774 (12 bit)

PIC16C712/716
PIC16C717/770/771 (12 bit)

PIC16C432/433 (LIN)
PIC16C925/926 (LCD)

PIC16C781/782

8-Pin PIC MCUs8-Pin PIC MCUs
High IntegrationHigh Integration

ROMs

ConnectivityConnectivity
RF andRF and
WiredWired

CSICs &CSICs &
VerticalsVerticals

PIC12F629
PIC12F675

PIC18F458/258 (CAN)
PIC16C745/765 (USB)
PIC16C432/433 (LIN)
rfPIC12C509AF/G

HCS101/201
HCS365/370
HCS412

ROM

CSIC & Verticals

Connectivity

Up-Integration

Tools
Pri. 1 - 8

PIC18C01 Emulator

Development Tools:
Whole Product

Development Tools:
Whole Product

88

777

666

555

PIC18C801
PIC18F8720

®
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80/84-Pin
Family64/68-Pin

Family
40/44-Pin

Family
28-Pin
Family

18/20-Pin
Family

14-Pin
Family

8-Pin
Family

.5KWord - 2KWord

1KWord

.5KWord - 4KWord

.5KWord - 16KWord

2KWord - 16KWord

4KWord - 16KWord

8KWord - 16KWord

Seamless Migration

159 Products
l Enhanced FLASH, OTP (EPROM),

EEPROM and  ROM program
memory

l Superior Analog functionality
l Industry’s strongest product and

family migration path

159 Products
l Enhanced FLASH, OTP (EPROM),

EEPROM and  ROM program
memory

l Superior Analog functionality
l Industry’s strongest product and

family migration path

PICmicro® MCU Product Migration Path
Today

PICmicroPICmicro®® MCU Product Migration Path MCU Product Migration Path
TodayToday
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PIC12C508APIC12C508A                      PIC12C672PIC12C672 PIC12F629PIC12F629
PIC12C509APIC12C509A                      PIC12C671PIC12C671 PIC12F675PIC12F675
PIC12CE518PIC12CE518                     PIC12CE673PIC12CE673
PIC12CE519PIC12CE519                     PIC12CE674PIC12CE674

GP4/OSC2/AN3/CLKOUT

GP3/MCLR/VPP

GP0/AN0

GP1/AN1/Vref

GP2/TOCKI/AN2/INT

GP5/OSC1/CLKIN

VDD

M

VSS

PICmicro® 8-Pin FamiliesPICmicroPICmicro®® 8-Pin Families 8-Pin Families
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PIC16CR620APIC16CR620A  PIC16C710PIC16C710     PIC16F627PIC16F627
PIC16C620APIC16C620A     PIC16C711PIC16C711     PIC16F628PIC16F628
PIC16C621APIC16C621A     PIC16C712PIC16C712     PIC16F84APIC16F84A
PIC16C622APIC16C622A     PIC16C715PIC16C715     PIC16F818PIC16F818
PIC16CE623PIC16CE623      PIC16C716PIC16C716     PIC16F819PIC16F819
PIC16CE624PIC16CE624    PIC16F87PIC16F87
PIC16CE625 PIC16CE625 PIC16F88PIC16F88

OSC2/CLKO/RA6MCLR/VPP/RA5/THV

RA0/AN0

RA1/AN1

RA3/AN3/CMP1/Vrefin

RA4/TOCKI/CMP2 OSC1/CLKI/RA7

RB7/T1OSI

RB6/ T1OSO/T1CKI

RB5

RB4/PGMRB3/CCP1

T1OSI /RB2/TX/CK

T1OSO/T1CKI /RB1/RX/DT

RB0/INT

VDDVSS

RA2/AN2/Vrefout

M

PICmicro® 18-Pin FamiliesPICmicroPICmicro®® 18-Pin Families 18-Pin Families
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PIC16C717PIC16C717  PIC16C781  PIC16C781     PIC18F1320PIC18F1320
PIC16C770PIC16C770   PIC16C782 PIC16C782     PIC18F1220PIC18F1220
PIC16C771PIC16C771     

OSC2/CLKOUT/RA6RA5/MCLR/VPP

RA0/AN0/OPA+

RA1/AN1/LVDIN/OPA-

RA2/AN2/Vrl/Vref-/PWM4

RA3/AN3/Vrh/Vref+/PWM5

RA4/TOCKI

AVSS

OSC1/CLKIN/RA7

RB7/T1OSI/P1D/ PSMC1B

RB6/T1OSO/T1CKI/P1C/PSMC1A

RB5/SDO/P1B/PWM3

RB4/SDI/SDA/PWM2

RB3/CCP1/P1A/OPA/PWM1

RB2/SCK/SCL/PWM0

RB1/AN5/SS/Vdac

RB0/AN4/INT/Vr

VDDVSS

AVDDM

PICmicro® 20-Pin FamiliesPICmicroPICmicro®® 20-Pin Families 20-Pin Families
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PIC16CR63PIC16CR63  PIC16CR72PIC16CR72 PIC16F73 PIC16F73 PIC18F242PIC18F242  PIC18F248PIC18F248
PIC16C62BPIC16C62B  PIC16C72APIC16C72A PIC16F76PIC16F76  PIC18F252PIC18F252  PIC18F258PIC18F258
PIC16C63APIC16C63A PIC16C73BPIC16C73B PIC16F870PIC16F870  PIC18F2450PIC18F2450  PIC18C242PIC18C242
PIC16C66PIC16C66  PIC16C76PIC16C76 PIC16F872PIC16F872  PIC18F2550PIC18F2550  PIC18C252PIC18C252
PIC16C642PIC16C642  PIC16C773PIC16C773  PIC16F873/APIC16F873/A  PIC18F2220PIC18F2220  

PIC16C745PIC16C745  PIC16F876/A PIC16F876/A PIC18F2320 PIC18F2320 

RC0/T1OSO/T1CKI
OSC2/CLKO/RA6

RC1/T1OSI/CCP2

MCLR/VPP
RA0/AN0
RA1/AN1

RA2/AN2/Vrl/Vref-
RA3/AN3/Vrh/Vref+

RA4/TOCKI
RA5/SS/AN4/AVDD/Lvdin

AVSS
OSC1/CLKI

RC2/CCP1
RC3/SCK/SCL

RB7/PGD
RB6/PGC
RB5/PGM
RB4
RB3/CCP2/CANRX
RB2/INT2/CANTX
RB1/INT1
RB0/INT0
VDD
VSS

RC6/TX/CK
RC5/SDO/D+
RC4/SDI/SDA/D-

RC7/RX/DT

M

PICmicro® 28-Pin FamiliesPICmicroPICmicro®® 28-Pin Families 28-Pin Families



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 17

RC0/T1OSO/T1CKI
OSC2/CLKO/RA6

RC1/T1OSI/CCP2

MCLR/VPP
RA0/AN0
RA1/AN1

RA2/AN2/Vrl/Vref-
RA3/AN3/Vrh/Vref+

RA4/TOCKI
RA5/SS/ AN4/AVDD/Lvdin

RE0/RD/AN5
RE1/WR/AN6
RE3/CS/AN7

AVDD
AVSS

OSC1/CLKI

RC2/CCP1
RC3/SCK/SCL

RD0/PSP0/C1IN+
RD1/PSP1/C1IN-

RB7/PGD/KBI3
RB6/PGC/KBI2
RB5/PGM/KBI1
RB4/KBI0
RB3/CCP2/CANRX
RB2/INT2/CANTX
RB1/INT1
RB0/INT0
VDD
VSS
RD7/PSP7/PD
RD6/PSP6/PC
RD5/PSP5/PB
RD4/PSP4/ECC/PA

RC6/TX/CK
RC5/SDO/D+
RC4/SDI/SDA/D-
RD3/SPS3/C2IN-
RD2/PSP2/C2IN+

RC7/RX/DT

PIC16CR65PIC16CR65  PIC16C74BPIC16C74B PIC16F74PIC16F74  PIC18F442PIC18F442  PIC18F448PIC18F448
PIC16C65BPIC16C65B  PIC16C77PIC16C77 PIC16F77PIC16F77 PIC18F452 PIC18F452 PIC18F458PIC18F458
PIC16C67PIC16C67  PIC16C774PIC16C774  PIC16F871PIC16F871 PIC18F4450 PIC18F4450 PIC18C442PIC18C442
PIC16C662PIC16C662 PIC16C765PIC16C765 PIC16F874/APIC16F874/A PIC18F4550PIC18F4550  PIC18C452PIC18C452

      PIC16F877/APIC16F877/A PIC18F4220PIC18F4220
PIC18F4320PIC18F4320     

M

PICmicro® 40-Pin FamiliesPICmicroPICmicro®® 40-Pin Families 40-Pin Families
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Quad Flat No Lead (QFN)Quad Flat No Lead (QFN)Quad Flat No Lead (QFN)

l Moving into a JEDEC
standard environment

l JEDEC is naming them:
l QFN (ala 28/40 lead)
l Quad Flat No Lead
l DFN (ala 8 lead)
l Dual Flat No Lead

l MCHP package ordering
names will not change

l /ML and /MF

l Moving into a JEDEC
standard environment

l JEDEC is naming them:
l QFN (ala 28/40 lead)
l Quad Flat No Lead
l DFN (ala 8 lead)
l Dual Flat No Lead

l MCHP package ordering
names will not change

l /ML and /MF
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(Millions of Units)(Millions of Units)
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Thousands of CustomersThousands of CustomersThousands of Customers

ConsumerConsumer

Black & DeckerBlack & Decker
ColemanColeman

GenieGenie

GoldstarGoldstar

Hamilton BeachHamilton Beach

JVCJVC

MitsubishiMitsubishi

PanasonicPanasonic

PhilipsPhilips

SamsungSamsung

SanyoSanyo

SegaSega

SonySony

SunbeamSunbeam

ToshibaToshiba

WhirlpoolWhirlpool

AutomotiveAutomotive

BMWBMW

FordFord

DelphiDelphi

HondaHonda

JCIJCI

LearLear

LexusLexus

Mercedes/BenzMercedes/Benz

NissanNissan

Robert BoschRobert Bosch

SagemSagem

Siemens/VDOSiemens/VDO

StribelStribel

ToyotaToyota

TRWTRW

ValeoValeo

     Office     Office
AutomationAutomation

AlpsAlps

Apple ComputerApple Computer

ConnerConner

CompaqCompaq

DECDEC

Dell ComputerDell Computer

Hewlett PackardHewlett Packard

IBMIBM

LogitechLogitech

MicrosoftMicrosoft

MitsumiMitsumi

NCRNCR

PanasonicPanasonic

QuantumQuantum

Texas InstrumentsTexas Instruments

TelecomTelecom

CodexCodex

EricssonEricsson

KyoceraKyocera

MotorolaMotorola

NokiaNokia

Northern Northern 
  Telecom  Telecom

Pacific Pacific 
   Monolithics   Monolithics

PulsecommPulsecomm

QualcommQualcomm

RockwellRockwell

SagemSagem

SamsungSamsung

SiemensSiemens

UDSUDS

IndustrialIndustrial

Allen-BradleyAllen-Bradley

American SensorsAmerican Sensors

BannerBanner

Code AlarmCode Alarm

FoxboroFoxboro

General ElectricGeneral Electric

HoneywellHoneywell

ILCO-Unican ILCO-Unican 

InvensysInvensys

Pitney BowesPitney Bowes

TandyTandy

UnitedUnited
  Technologies  Technologies

Wayne SystemsWayne Systems

WhirlpoolWhirlpool
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Process Technology
Advancements

Process TechnologyProcess Technology
AdvancementsAdvancements

S
S
P

PIC16C77 (0.9µ) PIC16C77 (0.7µ)* PIC16F77 (0.5µ)

* Equivalent device
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Worldwide 8-bit Microcontroller
Market Share - Units

Worldwide 8-bit MicrocontrollerWorldwide 8-bit Microcontroller
Market Share - UnitsMarket Share - Units

No.  1990 1991 1992 1993 1994 1995/96 1997-00
Rank    Rank Rank Rank Rank Rank Rank Rank 

   1 Motorola Motorola Motorola Motorola Motorola Motorola Motorola
2 Mitsubishi Mitsubishi Mitsubishi Mitsubishi Mitsubishi Mitsubishi Microchip
3 NEC NEC Intel NEC NEC SGS-Thomson NEC
4 Intel Intel NEC Hitachi Philips NEC Hitachi
5 Hitachi Hitachi Philips Philips Intel Microchip ST-Micro
6 Philips Philips Hitachi Intel Microchip Philips Infineon
7 Matsushita Matsushita Matsushita SGS Zilog Zilog Mitsubishi
8 National SGS-Thomson SGS Microchip SGS Hitachi Philips
9 Siemens Siemens National Matsushita Matsushita Fujitsu Toshiba

10 TI TI TI Toshiba Hitachi Intel Atmel
11 Sharp National Zilog National Toshiba Siemens Zilog
12 Oki Toshiba Toshiba Zilog National Toshiba Fujitsu
13 Toshiba Sony Siemens TI TI Matsushita Matsushita
14 SGS-ThomsonSharp Microchip Siemens Ricoh TI Realtek
15 Zilog Oki Sharp Sharp Fujitsu National Samsung
16 Matra MHS Zilog Sanyo Oki Siemens Temic National
17 Sony Microchip Matra MHS Sony Sharp Sanyo Sanyo
18 Fujitsu Matra MHS Sony Sanyo Oki Ricoh Elan
19 AMD Fujitsu Oki Fujitsu Sony Oki TI
20 Microchip Sanyo Fujitsu AMD Temic Sharp Sony

No.  1990 1991 1992 1993 1994 1995/96 1997-00
Rank    Rank Rank Rank Rank Rank Rank Rank 

   1 Motorola Motorola Motorola Motorola Motorola Motorola Motorola
2 Mitsubishi Mitsubishi Mitsubishi Mitsubishi Mitsubishi Mitsubishi Microchip
3 NEC NEC Intel NEC NEC SGS-Thomson NEC
4 Intel Intel NEC Hitachi Philips NEC Hitachi
5 Hitachi Hitachi Philips Philips Intel Microchip ST-Micro
6 Philips Philips Hitachi Intel Microchip Philips Infineon
7 Matsushita Matsushita Matsushita SGS Zilog Zilog Mitsubishi
8 National SGS-Thomson SGS Microchip SGS Hitachi Philips
9 Siemens Siemens National Matsushita Matsushita Fujitsu Toshiba

10 TI TI TI Toshiba Hitachi Intel Atmel
11 Sharp National Zilog National Toshiba Siemens Zilog
12 Oki Toshiba Toshiba Zilog National Toshiba Fujitsu
13 Toshiba Sony Siemens TI TI Matsushita Matsushita
14 SGS-ThomsonSharp Microchip Siemens Ricoh TI Realtek
15 Zilog Oki Sharp Sharp Fujitsu National Samsung
16 Matra MHS Zilog Sanyo Oki Siemens Temic National
17 Sony Microchip Matra MHS Sony Sharp Sanyo Sanyo
18 Fujitsu Matra MHS Sony Sanyo Oki Ricoh Elan
19 AMD Fujitsu Oki Fujitsu Sony Oki TI
20 Microchip Sanyo Fujitsu AMD Temic Sharp Sony

Based on unit shipment volume 1990-2000, Source:  Dataquest, July 2001
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PIC18 Architecture
And

Peripherals

PIC18 Architecture
And

Peripherals
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l High Performance 8-bit RISC CPU
l 40 MHz / 10 MIPs sustained operation
l 2.0V to 5.5V operation
l Linear Program Memory addressing to 2MB
l Linear Data Memory addressing to 4KB
l 3 Data Pointers with 5 addressing modes
l Relative conditional branch instructions

l High Performance 8-bit RISC CPU
l 40 MHz / 10 MIPs sustained operation
l 2.0V to 5.5V operation
l Linear Program Memory addressing to 2MB
l Linear Data Memory addressing to 4KB
l 3 Data Pointers with 5 addressing modes
l Relative conditional branch instructions

PIC18 Architecture
Features

PIC18 ArchitecturePIC18 Architecture
FeaturesFeatures
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PIC18 Architecture
Features (Continued)

PIC18 ArchitecturePIC18 Architecture
Features (Continued)Features (Continued)

l Up to 10MIPS @ 10MHz with 4X PLL
l Enhanced Flash memory

l 2 Seconds Programming Time
l Low Cost MPLAB-ICD-II Support
l Flexible Program Memory Protection

l And Many More...

l Up to 10MIPS @ 10MHz with 4X PLL
l Enhanced Flash memory

l 2 Seconds Programming Time
l Low Cost MPLAB-ICD-II Support
l Flexible Program Memory Protection

l And Many More...
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PIC18 Architecture
Harvard Architecture

PIC18 ArchitecturePIC18 Architecture
Harvard ArchitectureHarvard Architecture

l Separate memory spaces for instructions
and data
l Increased throughput
l Different program and data bus widths are possible

l Separate memory spaces for instructions
and data
l Increased throughput
l Different program and data bus widths are possible

“rom”
keyword
accessed

Flash

Program
Memory

(Up to 2MB)

PIC18

RISC
CPU

Data
Memory

(Up to 4KB)

816
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PIC18 Block DiagramPIC18 Block DiagramPIC18 Block Diagram

Program Memory
(up to 2M Bytes)

 Table Pointer <2> 

Inc/dec logic

PCLATU PCLATH

PCU PCH PCL

21
21

31 Level Stack

Program Counter
01010101

00100101

MULWF POSTINC1

0000 001 1 11100110

8  Instruction 
Register

Instruction
Decode

and
Control

Instruction
Decode

and
Control

8

0000 001

Data RAM
(up to

4K Bytes)

PORTS PERIPHERALS
Address<12>

12

FSR0

FSR1

FSR2

12

BSR

4

Address<12>

5 8 8

TABLELATCH 12

1

11100110

BIT OP

 PRODH   PRODL 

8 x 8
Multiply

8

8

ALU<8>

8

8

8

WREG

8

Power-up
Timer

Oscillator
Start-up

Timer
Power-on

Reset
Watchdog

Timer
Brown-out

Reset

Timing Generation

4X PLL

OSC2/CLK0
OSC1/CLK1

T1OS1
T1OSO

VDD,VSS, MCLR

VDD,VSS

8

00001100 01001001
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PIC18 Architecture
Oscillator

PIC18 ArchitecturePIC18 Architecture
OscillatorOscillator

l Various oscillator modesl Various oscillator modes
LP Low Power Crystal (200KHz max)
XT Crystal/Resonator (4MHz max)
HS High Speed Crystal/Resonator (40MHz max)
HS + PLL HS + 4X PLL (10MHz max)
RC External RC (4MHz max)
RCIO RC with OSC2 as I/O (4MHz max)
EC External Clock (40MHz max)
ECIO EC with OSC2 as I/O (40MHz max)
INTOSC Internal RC Oscillator (30/500 kHz, 1/4/8 MHz)

Secondary Oscillator Mode
Modes selected by Configuration registers
Secondary Oscillator Mode
Modes selected by Configuration registers
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PIC18 Architecture
Clocking Scheme

PIC18 ArchitecturePIC18 Architecture
Clocking SchemeClocking Scheme

l Instruction cycle = 1/4 of clock input
frequency

l 100 ns Instruction cycle at 40 MHz clock

l Instruction cycle = 1/4 of clock input
frequency

l 100 ns Instruction cycle at 40 MHz clock

OSC1

Q1

Q2

Q4

Q3

OSC2

Q1 Q2 Q3 Q4 Q1 Q2 Q3 Q4

1  instruction cycle
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Fetch SUB_1+1Fetch SUB_1+1

Exec. SUB_1Exec. SUB_1Fetch SUB_1Fetch SUB_1
Forced NOPForced NOPFetch 2bFetch 2b

Exec. 2 Exec. 2 

Fetch 1Fetch 1

l Allows overlap of fetch and execution
l Makes single cycle execution
l Program branches (e.g. GOTO, CALL or Write

to PC) take two or three cycles

l Allows overlap of fetch and execution
l Makes single cycle execution
l Program branches (e.g. GOTO, CALL or Write

to PC) take two or three cycles

PIC18 Architecture
Instruction Pipeline

PIC18 ArchitecturePIC18 Architecture
Instruction PipelineInstruction Pipeline

1.1.      MOVWFMOVWF    PORTBPORTB Exec. 1Exec. 1

Fetch 2Fetch 22.2.      RCALL SUB_1RCALL SUB_1
2b.2b.  Forced NOPForced NOP
3.3.      BSF PORTA, RA3BSF PORTA, RA3

TCY0   TCY1       TCY2        TCY3           TCY4
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WREG RegisterWREG Register

PIC18 Architecture
ALU

PIC18 ArchitecturePIC18 Architecture
ALUALU

Special FunctionSpecial Function
Registers (Registers (SFRSFR))

Other BanksOther Banks
Bank 5Bank 5
Bank 4Bank 4
Bank 3Bank 3
Bank 2Bank 2
Bank 1Bank 1
Bank 0Bank 0 ll Operates on WREGOperates on WREG

and a Register or and a Register or 
ConstantConstant

ll Multi-Byte  Multi-Byte 
calculation using calculation using 
ADDWFCADDWFC etc. etc.

ALUALU

IRIRConstantConstant

RegisterRegister

OROR
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PIC18 Architecture
8 x 8 Hardware Multiplier
PIC18 ArchitecturePIC18 Architecture
8 x 8 Hardware Multiplier8 x 8 Hardware Multiplier

l Single Cycle Hardware Multiplier
l Performs

l WREG X Register
l WREG X Constant

l 16-bit result stored in PRODH:PRODL
l Integer arithmetic operation
l Unsigned operation

l Single Cycle Hardware Multiplier
l Performs

l WREG X Register
l WREG X Constant

l 16-bit result stored in PRODH:PRODL
l Integer arithmetic operation
l Unsigned operation
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PIC18 Architecture
Computation Performance
PIC18 ArchitecturePIC18 Architecture

Computation PerformanceComputation Performance

  Function
Prog  Words
(estimated)

RAM
(estimated)

Max Time (uS)
 @ 10MIPS

  8 x 8 unsigned multiply 1 - 0.1

  16 X 16 unsigned multiply 30 7 3

  16 X 16 signed multiply 40 8 4

  32 x 32 signed multiply 140 18 15

  32 / 16 signed divide 450 9 42

  Float Add (IEEE 32bit) 320 12 7

  Float Mul (IEEE 32bit) 350 13 10

  Float Div (IEEE 32bit) 130 14 32

  Sqrt (32bit) 320 10 57

  Sin (32bit) 420 11 241
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PIC18 Architecture
Indirect Access

PIC18 ArchitecturePIC18 Architecture
Indirect AccessIndirect Access

l Indirect Addressing
l Three 12-bit FSRs
l FSRnH:FSRnL (0 ≤ n ≤ 2)

l Linear access to 4KB
l Special Instruction to load

FSRn in 2 cycles
l De-reference  operations

l Unchanged
l Pre/Post Increment
l Post Decrement
l Indexed by WREG (signed)

l Indirect Addressing
l Three 12-bit FSRs
l FSRnH:FSRnL (0 ≤ n ≤ 2)

l Linear access to 4KB
l Special Instruction to load

FSRn in 2 cycles
l De-reference  operations

l Unchanged
l Pre/Post Increment
l Post Decrement
l Indexed by WREG (signed)

GPR (Bank n-1)

GPR (Bank n)

GPR (Bank n+1)

12-bit FSR12-bit FSR
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PIC18 Architecture
Stack Memory

PIC18 ArchitecturePIC18 Architecture
Stack MemoryStack Memory

l Hardware stack - 31 levels deep
l Separate memory, pointed by STKPTR
l Used by CALL, RCALL, INT, RETURN, RETFIE

l Hardware stack - 31 levels deep
l Separate memory, pointed by STKPTR
l Used by CALL, RCALL, INT, RETURN, RETFIE

Stack Level 1

...

Stack Level 31

Stack Level 0 RESET State; No RAM at this location

Stack Grows “Upward”
*(++STKPTR)

l Software stack uses FSRn, not hardware stack
l Uses general purpose RAM, pointed by FSRn
l Used to store local variables for re-entrant functions

20                        0 

STKPTR<4:0>
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PIC18 Architecture
Accessing HW Stack

PIC18 ArchitecturePIC18 Architecture
Accessing HW StackAccessing HW Stack

TOSUTOSU TOSHTOSH TOSLTOSL

Top-Of-StackTop-Of-Stack

l 5-bit Stack Ptr addresses 21-bit wide stack
l Top-Of-Stack = TOSU:TOSH:TOSL

l Readable & Writeable => RTOS Friendly

l PUSH puts current PC on Top-Of-Stack
l POP discards Top-Of-Stack
l When enabled, Stack OV resets the device
l Stack Underflow returns 00000h

l 5-bit Stack Ptr addresses 21-bit wide stack
l Top-Of-Stack = TOSU:TOSH:TOSL

l Readable & Writeable => RTOS Friendly

l PUSH puts current PC on Top-Of-Stack
l POP discards Top-Of-Stack
l When enabled, Stack OV resets the device
l Stack Underflow returns 00000h
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PIC18 Architecture
Program Memory

PIC18 ArchitecturePIC18 Architecture
Program MemoryProgram Memory

l Up to 2M x 8 in size*
l Linear access
l Two Interrupt Vectors
l Self programmable*
l Programmable over entire

voltage range
l Flexible Code Protection

Modes*
l 100 K erase/writes (typical)*
l > 40 years retention (typical)

l Up to 2M x 8 in size*
l Linear access
l Two Interrupt Vectors
l Self programmable*
l Programmable over entire

voltage range
l Flexible Code Protection

Modes*
l 100 K erase/writes (typical)*
l > 40 years retention (typical)

* Note: Check your device datasheet* Note: Check your device datasheet

Reset Vector

High Priority Interrupt Vector

Low Priority Interrupt Vector

Rest Of
Program Memory

Unimplemented
Read ‘0’

000000h000000h

000008h000008h

000018h000018h

1FFFFFh1FFFFFh
200000h200000h

8-bit Wide8-bit Wide
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PIC18 Architecture
Program Memory Organization

PIC18 ArchitecturePIC18 Architecture
Program Memory OrganizationProgram Memory Organization

l Divided into blocks
l 512 bytes of Boot block*
l Block size varies by device

l 8KB on PIC18F452

l Blocks erased in bulk or 64*
bytes
l Bulk erase in ICSP™

programming mode (4.5 - 5.5V)

l Code protection by block
l Internal Read/Write protection

by block

l Divided into blocks
l 512 bytes of Boot block*
l Block size varies by device

l 8KB on PIC18F452

l Blocks erased in bulk or 64*
bytes
l Bulk erase in ICSP™

programming mode (4.5 - 5.5V)

l Code protection by block
l Internal Read/Write protection

by block

Boot Block

Block 0

Block 1

...

Read ‘0’
Or

External
Memory

00
512512

2 M2 M

8-bit Wide8-bit Wide

* Note: Check your device datasheet* Note: Check your device datasheet
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PIC18 Architecture
Program Memory : Protection

PIC18 ArchitecturePIC18 Architecture
Program Memory : ProtectionProgram Memory : Protection

44

88

Internal Read ProtectionInternal Read Protection

Block n

Block n+1

Internal Write ProtectionInternal Write Protection

88

Block n

Block n+1

88

Three types of Protection Scheme:Three types of Protection Scheme:

88 Block n

Code ProtectionCode Protection

Block n+1

88
ICSP ICSP progprog..
InterfaceInterface

ICSP programming modeICSP programming mode
Read and Write disabledRead and Write disabled

Reads from same block OK,Reads from same block OK,
reads from other blocks disabledreads from other blocks disabled

Self Write to this block are disabledSelf Write to this block are disabled
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PIC18 Architecture
Program Memory Modes
PIC18 ArchitecturePIC18 Architecture
Program Memory ModesProgram Memory Modes

Microprocessor Microprocessor 
ModeMode

External
Program
Memory

External
Program
Memory

00

2M2M

00

4K 4K 
InternalInternal

Note: Check your device datasheetNote: Check your device datasheet

Extended Extended 
Microcontroller Microcontroller 

ModeMode

2M2M

00

00

4K 4K 
InternalInternal

Internal
Boot Block
Internal

Boot Block 512512
Internal
Program

Flash

Internal
Program

Flash

External
Program
Memory

External
Program
Memory

Four Modes:Four Modes:
MicroprocessorMicroprocessor

WithWith
Boot Block ModeBoot Block Mode

Internal
Boot Block
Internal

Boot Block

External
Program
Memory

External
Program
Memory

2M2M

00

00

4K 4K 
InternalInternal

512512

ProgramProgram
SpaceSpace

DataData
SpaceSpace

Microcontroller Microcontroller 
ModeMode

00

2M2M

00

4K 4K 
InternalInternal

Internal
Boot Block
Internal

Boot Block 512512
Internal
Program

Flash

Internal
Program

Flash

Read as ‘0’Read as ‘0’
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PIC18 Architecture
Accessing Program Memory

PIC18 ArchitecturePIC18 Architecture
Accessing Program MemoryAccessing Program Memory

l 21-bit Divided into PCU:PCH:PCL
l PCL is readable/writeable
l PCU:PCH is readable/writeable via shadow

registers only

l PCL<0> is forced to ‘0’

l 21-bit Divided into PCU:PCH:PCL
l PCL is readable/writeable
l PCU:PCH is readable/writeable via shadow

registers only

l PCL<0> is forced to ‘0’

PCLUPCLU PCLHPCLH

PCLATUPCLATU PCLATHPCLATH PCLPCL

Program CounterProgram Counter

Program Memory
2 M2 M

00

16-bit Wide16-bit Wide
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MSB LSB

Program MemoryProgram Memory

PIC18 Architecture
Reading Program Memory
PIC18 ArchitecturePIC18 Architecture

ReadingReading  Program MemoryProgram Memory

TBLPTRUTBLPTRU TBLPTRHTBLPTRH TBLPTRL<7:1>TBLPTRL<7:1> <0><0> TABLATTABLAT

TBLPTRL<0>=0  => LSB
TBLPTRL<0>=1  => MSB
TBLPTRL<0>=0  => LSB
TBLPTRL<0>=1  => MSB

TBLRDTBLRD Operation Operation

tblrd*+
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PIC18 Architecture
 Writing to Program Memory

PIC18 ArchitecturePIC18 Architecture
  Writing to Program MemoryWriting to Program Memory

TBLPTRU    TBLPTRH    TBLPTRL

TABLAT

Table Pointer

Internal Program Memory

Holding
Latch

tblwt*+

HIGH BYTE  (ODD ADDR)

LOW BYTE (EVEN ADDR)

tblwt*

movff  LOW(DATA),TABLAT

movff  HIGH(DATA),TABLAT

LOW(DATA)

LOW(DATA)

HIGH(DATA)

See Appendix C for more informationSee Appendix C for more information
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PIC18 Architecture
Accessing Program Memory (Cont.)

PIC18 ArchitecturePIC18 Architecture
Accessing Program Memory (Accessing Program Memory (ContCont.).)

l TBLPTR is used to address program memory
l Divided in TBLPTRU:TRBLPTRH:TBLPTRL

l TBLRD is used to read a byte
l TBLWT is used to load write buffer

l EECON1 register controls actual write cycle
l Protected against “run-away” code

l Erase block size 32 or 64 bytes*
l 8 bytes written at a time

l TBLPTR is used to address program memory
l Divided in TBLPTRU:TRBLPTRH:TBLPTRL

l TBLRD is used to read a byte
l TBLWT is used to load write buffer

l EECON1 register controls actual write cycle
l Protected against “run-away” code

l Erase block size 32 or 64 bytes*
l 8 bytes written at a time

* Note: Check your device datasheet* Note: Check your device datasheet
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Table Pointer OperationsTable Pointer OperationsTable Pointer Operations

l To enhance flexibility of table operations, the
TBLPTR automatically increment and decrement
during read/write operations

l PIC18 devices have 4 modify modes for TBLPTR

tblwt* tblrd* no change
tblwt*+ tblrd*+ auto post increment
tblwt*- tblrd*- auto post decrement
tblwt+* tblrd+* auto pre increment

l To enhance flexibility of table operations, the
TBLPTR automatically increment and decrement
during read/write operations

l PIC18 devices have 4 modify modes for TBLPTR

tblwt* tblrd* no change
tblwt*+ tblrd*+ auto post increment
tblwt*- tblrd*- auto post decrement
tblwt+* tblrd+* auto pre increment
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PIC18 Architecture
Data EEPROM

PIC18 ArchitecturePIC18 Architecture
Data EEPROMData EEPROM

l Size ranges from 64 to 1024 bytes
l 1 M erase/write cycles (typical)
l > 40 years retention (typical)
l Read and Written at byte boundary

l Automatic Erase-Before-Write

l Protection against “run-away” code
l Code Protection And Internal Write Protection
l Accessed via EEADR, EEDATA and

EECONn registers

l Size ranges from 64 to 1024 bytes
l 1 M erase/write cycles (typical)
l > 40 years retention (typical)
l Read and Written at byte boundary

l Automatic Erase-Before-Write

l Protection against “run-away” code
l Code Protection And Internal Write Protection
l Accessed via EEADR, EEDATA and

EECONn registers
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PIC18 Architecture
Configuration

PIC18 ArchitecturePIC18 Architecture
ConfigurationConfiguration

l Configuration Registers at 300000h
l Bit(s) enable/define mode(s)
l Written one byte at a time
l Writeable in all modes

l Special “Configuration Write Protect” bit

l Most bits can be written to either ‘1’ or ‘0’
l Code, Read and Write Protection bits can be

written ‘1’ -> ‘0’ only
l Bulk Erase required to reset Code, Read and

Write Protection bits to a ‘1’

l Configuration Registers at 300000h
l Bit(s) enable/define mode(s)
l Written one byte at a time
l Writeable in all modes

l Special “Configuration Write Protect” bit

l Most bits can be written to either ‘1’ or ‘0’
l Code, Read and Write Protection bits can be

written ‘1’ -> ‘0’ only
l Bulk Erase required to reset Code, Read and

Write Protection bits to a ‘1’
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Specifying Configuration
Information in Source File
Specifying ConfigurationSpecifying Configuration
Information in Source FileInformation in Source File

l Create “config.asm” file and include in project:
#include p18f452.inc
__CONFIG _CONFIG1L,0xFF
__CONFIG _CONFIG1H,_OSCS_OFF_1H&_HSPLL_OSC_1H
__CONFIG _CONFIG2L,_BOR_OFF_2L&_BORV_20_2L&_PWRT_OFF_2L
__CONFIG _CONFIG2H,_WDT_OFF_2H&_WDTPS_128_2H
__CONFIG _CONFIG3L,0xFF
__CONFIG _CONFIG3H,_CCP2MX_OFF_3H
__CONFIG _CONFIG4L,_STVR_ON_4L&_LVP_OFF_4L&_DEBUG_OFF_4L
__CONFIG _CONFIG4H,0xFF
__CONFIG _CONFIG5L,_CP0_OFF_5L&_CP1_OFF_5L&_CP2_OFF_5L&_CP3_OFF_5L
__CONFIG _CONFIG5H,_CPB_OFF_5H&_CPD_OFF_5H
__CONFIG _CONFIG6L,_WRT0_OFF_6L&_WRT1_OFF_6L&_WRT2_OFF_6L&_WRT3_OFF_6L
__CONFIG _CONFIG6H,_WRTC_OFF_6H&_WRTB_OFF_6H&_WRTD_OFF_6H
__CONFIG _CONFIG7L,_EBTR0_OFF_7L&_EBTR1_OFF_7L&_EBTR2_OFF_7L&_EBTR3_OFF_7L
__CONFIG _CONFIG7H,_EBTRB_OFF_7H
END

l Create “config.asm” file and include in project:
#include p18f452.inc
__CONFIG _CONFIG1L,0xFF
__CONFIG _CONFIG1H,_OSCS_OFF_1H&_HSPLL_OSC_1H
__CONFIG _CONFIG2L,_BOR_OFF_2L&_BORV_20_2L&_PWRT_OFF_2L
__CONFIG _CONFIG2H,_WDT_OFF_2H&_WDTPS_128_2H
__CONFIG _CONFIG3L,0xFF
__CONFIG _CONFIG3H,_CCP2MX_OFF_3H
__CONFIG _CONFIG4L,_STVR_ON_4L&_LVP_OFF_4L&_DEBUG_OFF_4L
__CONFIG _CONFIG4H,0xFF
__CONFIG _CONFIG5L,_CP0_OFF_5L&_CP1_OFF_5L&_CP2_OFF_5L&_CP3_OFF_5L
__CONFIG _CONFIG5H,_CPB_OFF_5H&_CPD_OFF_5H
__CONFIG _CONFIG6L,_WRT0_OFF_6L&_WRT1_OFF_6L&_WRT2_OFF_6L&_WRT3_OFF_6L
__CONFIG _CONFIG6H,_WRTC_OFF_6H&_WRTB_OFF_6H&_WRTD_OFF_6H
__CONFIG _CONFIG7L,_EBTR0_OFF_7L&_EBTR1_OFF_7L&_EBTR2_OFF_7L&_EBTR3_OFF_7L
__CONFIG _CONFIG7H,_EBTRB_OFF_7H
END
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C Programmer’s
Interface

C Programmer’sC Programmer’s
InterfaceInterface
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Accessing Peripheral Control
and Status Bits

Accessing Peripheral ControlAccessing Peripheral Control
and Status Bitsand Status Bits

l All peripheral control bits set up in
<processor>.h file as:

<peripheral register name>bits.<bit name>

l Example:
l GIEH bit of INTCON can be accessed by:

INTCONbits.GIEH

l All peripheral control bits set up in
<processor>.h file as:

<peripheral register name>bits.<bit name>

l Example:
l GIEH bit of INTCON can be accessed by:

INTCONbits.GIEH
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Reset VectorReset VectorReset Vector

l Located at 0x00000, compiler automatically initializes
variables

l Calls main() after variable initialization
l Loops back and calls main() again if main exits
l Generally, main() should stay in loop and not exit:
void main(void){

// Place your initialization code here

while(1){
// Place your main loop here
}

}

l Located at 0x00000, compiler automatically initializes
variables

l Calls main() after variable initialization
l Loops back and calls main() again if main exits
l Generally, main() should stay in loop and not exit:
void main(void){

// Place your initialization code here

while(1){
// Place your main loop here
}

}
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PIC18 Architecture
Interrupt Overview

PIC18 ArchitecturePIC18 Architecture
Interrupt OverviewInterrupt Overview

l Interrupt Sources can individually
l Assigned to high or low priority vector

l High Priority Vector at 000008h (Default)
l Low  Priority Vector at 000018h

l Polled or interrupt driven

l Automatic context save WREG, STATUS
and BSR on High Priority Interrupt

l Most interrupts wake processor from sleep
l Fixed interrupt latency is three instruction

cycles

l Interrupt Sources can individually
l Assigned to high or low priority vector

l High Priority Vector at 000008h (Default)
l Low  Priority Vector at 000018h

l Polled or interrupt driven

l Automatic context save WREG, STATUS
and BSR on High Priority Interrupt

l Most interrupts wake processor from sleep
l Fixed interrupt latency is three instruction

cycles
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PIC18 Architecture
Interrupt Logic (High Priority Level)

PIC18 ArchitecturePIC18 Architecture
Interrupt Logic (High Priority Level)Interrupt Logic (High Priority Level)

TMR0IFTMR0IF
TMR0IETMR0IE
TMR0IPTMR0IP

RBIFRBIF
RBIERBIE
RBIPRBIP

INT0IFINT0IF
INT0IEINT0IE

INT1IFINT1IF
INT1IEINT1IE
INT1IPINT1IP
INT2IFINT2IF
INT2IEINT2IE
INT2IPINT2IP

Peripheral Interrupt Enabled bitPeripheral Interrupt Enabled bit
Peripheral Interrupt Flag bitPeripheral Interrupt Flag bit

Peripheral Interrupt Priority bitPeripheral Interrupt Priority bit

Additional Peripheral InterruptsAdditional Peripheral Interrupts

IPENIPEN

IPENIPEN
GIEL/PEIEGIEL/PEIE

From (a)From (a)
IPENIPEN

From (b)From (b)

GIEH/GIEGIEH/GIE

Interrupt to CPUInterrupt to CPU
Vector to locationVector to location
0008h0008h
(High Priority (High Priority 
InterruptInterrupt
Vector Address)Vector Address)

High Priority Interrupt initializedHigh Priority Interrupt initialized
(Disable low priority interrupts)(Disable low priority interrupts)

High Priority Interrupt GenerationHigh Priority Interrupt Generation

To (c)To (c)



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 54

PIC18 Architecture
Interrupt Logic (Low Priority Level)

PIC18 ArchitecturePIC18 Architecture
Interrupt Logic (Low Priority Level)Interrupt Logic (Low Priority Level)

TMR0IFTMR0IF
TMR0IETMR0IE
TMR0IPTMR0IP

RBIFRBIF
RBIERBIE
RBIPRBIP

INT1IFINT1IF
INT1IEINT1IE
INT1IPINT1IP
INT2IFINT2IF
INT2IEINT2IE
INT2IPINT2IP

Peripheral Interrupt Enabled bitPeripheral Interrupt Enabled bit
Peripheral Interrupt Flag bitPeripheral Interrupt Flag bit

Peripheral Interrupt Priority bitPeripheral Interrupt Priority bit

Additional Peripheral InterruptsAdditional Peripheral Interrupts

To (a)To (a)

To (b)To (b)

From (c)From (c)

GIEH/GIE, GIEL/PEIEGIEH/GIE, GIEL/PEIE

Interrupt to CPUInterrupt to CPU
Vector to LocationVector to Location
0018h (Low0018h (Low
Priority InterruptPriority Interrupt
Vector Address)Vector Address)

Wake-upWake-up
(if in SLEEP mode)(if in SLEEP mode)
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Interrupt Priority EnableInterrupt Priority EnableInterrupt Priority Enable

IPEN LWRT - RI TO PD POR BOR
R/W-0 R/W-0 U-0 R/W-1 R/W-1 R/W-1 R/W-0 R/W-0

bit7 6 5 4 3 2 1

l New bit added to the RCON register - IPEN

l Enables / Disables Interrupt Priority and 16C Compatibility
l If IPEN=0, priority is disabled and the interrupts are

compatible with 16C  (default)
l If IPEN=1, priority is enabled and the interrupts are NOT

compatible with 16C

l Registers have been added to set priority for each interrupt
source, except INT0.

l New bit added to the RCON register - IPEN

l Enables / Disables Interrupt Priority and 16C Compatibility
l If IPEN=0, priority is disabled and the interrupts are

compatible with 16C  (default)
l If IPEN=1, priority is enabled and the interrupts are NOT

compatible with 16C

l Registers have been added to set priority for each interrupt
source, except INT0.

0
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Peripheral Interrupt Control
Registers

Peripheral Interrupt ControlPeripheral Interrupt Control
RegistersRegisters

PSPIF ADIF RCIF TXIF SSPIF CCP1IF TMR2IF TMR1IF
R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

bit7 6 5 4 3 2 1
PIR1

PSPIE ADIE RCIE TXIE SSPIE CCP1IE TMR2IE TMR1IE
R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

bit7 6 5 4 3 2 1
PIE1

PSPIP ADIP RCIP TXIP SSPIP CCP1IP TMR2IP TMR1IP
R/W-1 R/W-1 R/W-1 R/W-1 R/W-1 R/W-1 R/W-1 R/W-1

bit7 6 5 4 3 2 1
IPR1

- - - - BCLIF LVDIF TMR3IF CCP2IF
U-0 U-0 U-0 U-0 R/W-0 R/W-0 R/W-0 R/W-0

bit7 6 5 4 3 2 1
PIR2

- - - - BCLIE LVDIE TMR3IE CCP2IE
U-0 U-0 U-0 U-0 R/W-0 R/W-0 R/W-0 R/W-0

bit7 6 5 4 3 2 1
PIE2

- - - - BCLIP LVDIP TMR3IP CCP2IP
U-0 U-0 U-0 U-0 R/W-1 R/W-1 R/W-1 R/W-1

bit7 6 5 4 3 2 1
IPR2

0

0

0

0

0

0
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GIE  PEIE In Compatibility
Mode

GIE  PEIE In CompatibilityGIE  PEIE In Compatibility
ModeMode

l When IPEN=0 Compatibility Mode
l INTCON<7> is GIE
l INTCON<6> is PEIE
l Note: definition exactly same as 16C INTCON

l When IPEN=0 Compatibility Mode
l INTCON<7> is GIE
l INTCON<6> is PEIE
l Note: definition exactly same as 16C INTCON

GIE/GIEH PEIE/GIEL INT0E RBIE T0IF INT0F RBIF
R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

bit7 6 5 4 3 2 1
T0IE
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GIEH & GIEL In Priority ModeGIEH & GIEL In Priority ModeGIEH & GIEL In Priority Mode

l When IPEN=1 Priority Interrupt Mode

l INTCON<7> is GIEH
l INTCON<6> is GIEL

l High Priority Interrupt Enable GIEH replaces GIE
l Low Priority Interrupt Enable GIEL replaces PEIE

l When IPEN=1 Priority Interrupt Mode

l INTCON<7> is GIEH
l INTCON<6> is GIEL

l High Priority Interrupt Enable GIEH replaces GIE
l Low Priority Interrupt Enable GIEL replaces PEIE

GIE/GIEH PEIE/GIEL INT0E RBIE T0IF INT0F RBIF
R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

bit7 6 5 4 3 2 1
T0IE
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High Priority InterruptsHigh Priority InterruptsHigh Priority Interrupts

l High Priority Vector uses shadow registers for
automatic context save / restore:

#pragma code HighVector=0x8
void HighVector (void)

{ _asm GOTO high_priority_interrupt _endasm}

#pragma code // return to default code section

#pragma interrupt high_priority_interrupt save=[symbol]
void high_priority_interrupt (void){

// Place your high priority interrupt code here
}

l High Priority Vector uses shadow registers for
automatic context save / restore:

#pragma code HighVector=0x8
void HighVector (void)

{ _asm GOTO high_priority_interrupt _endasm}

#pragma code // return to default code section

#pragma interrupt high_priority_interrupt save=[symbol]
void high_priority_interrupt (void){

// Place your high priority interrupt code here
}
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Low Priority InterruptsLow Priority InterruptsLow Priority Interrupts

l Low Priority Vector - compiler saves context and
restores it with “interruptlow” pragma

#pragma code lowVector=0x18
void LowVector (void)
{
_asm GOTO low_priority_interrupt _endasm
}
#pragma code

#pragma interruptlow low_priority_interrupt save=[symbol]
void low_priority_interrupt (void){

// Place your low priority interrupt code here
}

l Low Priority Vector - compiler saves context and
restores it with “interruptlow” pragma

#pragma code lowVector=0x18
void LowVector (void)
{
_asm GOTO low_priority_interrupt _endasm
}
#pragma code

#pragma interruptlow low_priority_interrupt save=[symbol]
void low_priority_interrupt (void){

// Place your low priority interrupt code here
}
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Interrupt Context Save /
Restore

Interrupt Context Save /Interrupt Context Save /
RestoreRestore

l High priority interrupt uses Hardware shadow
registers to save and restore
WREG,BSR,STATUS.

l Low priority interrupt uses the software stack to
manually save WREG,BSR,STATUS.

l You need to add save=[symbol or section] if your
ISR is complicated by:
l Accessing a calculated index within an array
l Calls other user functions
l Performs complex math (*,/,float)
l Accesses a ROM qualified variable

l High priority interrupt uses Hardware shadow
registers to save and restore
WREG,BSR,STATUS.

l Low priority interrupt uses the software stack to
manually save WREG,BSR,STATUS.

l You need to add save=[symbol or section] if your
ISR is complicated by:
l Accessing a calculated index within an array
l Calls other user functions
l Performs complex math (*,/,float)
l Accesses a ROM qualified variable
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Guidelines for ISR Save
Context

Guidelines for ISR SaveGuidelines for ISR Save
ContextContext

ISR Code Behavior

Call functions that are also called within
main code paths

Access values in Program Memory such as
an array declared with the ROM keyword

Performs Multiplication or accesses a
calculated index of an array

Executes Division, 16 bit or greater
Multiplication, Floating Point, Scientific
functions

Symbol or Section added to

ISR Save List

section(".tmpdata"), PROD

TABLPTR, TABLAT

PROD

section("MATH_DATA")

Example: ISR accesses a calculated array index and executes a division within the ISR:

#pragma interrupt sample_adc save=PROD, section("MATH_DATA")



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 63

Large Arrays and StructuresLarge Arrays and StructuresLarge Arrays and Structures

l Linker attempts to fit each variable into a
default 256 byte section

l Need to create a larger protected section for
arrays and structures larger than 256 bytes:

l Modify <processor name>.lkr file as follows:

DATABANK NAME=gpr2       START=0x200 END=0x2FF
DATABANK NAME=big_array1 START=0x300 END=0x4FF PROTECTED
DATABANK NAME=gpr5       START=0x500 END=0x5FF
SECTION  NAME=big_array  RAM=big_array1

l Linker attempts to fit each variable into a
default 256 byte section

l Need to create a larger protected section for
arrays and structures larger than 256 bytes:

l Modify <processor name>.lkr file as follows:

DATABANK NAME=gpr2       START=0x200 END=0x2FF
DATABANK NAME=big_array1 START=0x300 END=0x4FF PROTECTED
DATABANK NAME=gpr5       START=0x500 END=0x5FF
SECTION  NAME=big_array  RAM=big_array1
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Large Arrays and Structures
(cont.)

Large Arrays and StructuresLarge Arrays and Structures
((contcont.).)

l Add #pragma to use new section in source.c
#pragma udata big_array // Select large section

unsigned char test[456];
#pragma udata // Return to normal section

l Access these large (>256 byte) arrays and
structures through pointers or a variable
based index (array[index] or *array)
l Avoid fixed element addressing on these large

arrays and structures (ex: array[2])

l Pointers are more code efficient than array
indexing

l Add #pragma to use new section in source.c
#pragma udata big_array // Select large section

unsigned char test[456];
#pragma udata // Return to normal section

l Access these large (>256 byte) arrays and
structures through pointers or a variable
based index (array[index] or *array)
l Avoid fixed element addressing on these large

arrays and structures (ex: array[2])

l Pointers are more code efficient than array
indexing
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PeripheralsPeripheralsPeripherals
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PIC18 PeripheralsPIC18 PeripheralsPIC18 Peripherals

l Digital I/O Ports
l Timer0, 1, 2, 3
l Compare/Capture/PWM (CCP)
l Analog-To-Digital Converter
l Analog Comparator
l Addressable USART (AUSART)
l Master Synchronous Serial Port (MSSP)
l External Memory Access (EMA)
l Controller Area Network (CAN)

l Digital I/O Ports
l Timer0, 1, 2, 3
l Compare/Capture/PWM (CCP)
l Analog-To-Digital Converter
l Analog Comparator
l Addressable USART (AUSART)
l Master Synchronous Serial Port (MSSP)
l External Memory Access (EMA)
l Controller Area Network (CAN)
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PIC18 Peripherals
Digital I/O Ports

PIC18 PeripheralsPIC18 Peripherals
Digital I/O PortsDigital I/O Ports

l Up to 68 bi-directional I/O pins

l High sink/source capability (up to 25mA)

l Direct bit (pin) manipulation (single-cycle)

l Each port pin has:
l Individual direction control (TRISA~TRISJ)

l Data Latch (LATA~LATJ - read-modify-writes)

l Port Register (PORTA~PORTJ reads value

on pins)

l All I/O pins have ESD protection

l Up to 68 bi-directional I/O pins

l High sink/source capability (up to 25mA)

l Direct bit (pin) manipulation (single-cycle)

l Each port pin has:
l Individual direction control (TRISA~TRISJ)

l Data Latch (LATA~LATJ - read-modify-writes)

l Port Register (PORTA~PORTJ reads value

on pins)

l All I/O pins have ESD protection
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Port Latch Block DiagramPort Latch Block DiagramPort Latch Block Diagram

Data Bus

Write PORT
or LAT

Write TRIS 

I/O Pin

Data Latch

TRIS Latch

• •

I/O pins have ESD protection diodesI/O pins have ESD protection diodes

D Q

D Q

•

  Q   D

EN

•

•

Read PORT

TTL
Input
Buffer

4CK

4CK

¡

Read TRIS

•

Read LAT

Q1

PORT Input 
Synchronizer Latch
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I/O Pin DirectionI/O Pin DirectionI/O Pin Direction

l Direction of I/O pins controlled by individual
TRIS bits
l 1 = Input (default power on reset state)
l 0 = Output

l Example

TRISAbits.TRISA5 = 0; // Make RA5 output
TRISB = 0b11110000;  // Make RB0:3 outputs,

 // RB4:7 inputs

l Direction of I/O pins controlled by individual
TRIS bits
l 1 = Input (default power on reset state)
l 0 = Output

l Example

TRISAbits.TRISA5 = 0; // Make RA5 output
TRISB = 0b11110000;  // Make RB0:3 outputs,

 // RB4:7 inputs
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Reading / Writing I/O PortsReading / Writing I/O PortsReading / Writing I/O Ports

l Reading a I/O port or bit uses the PORT
register
l if (PORTCbits.RC2) // Execute if RC2 = 1
l if (PORTC == 0b11110000) // Check for F0

l Writing to an I/O port or bit should use LAT
register
l LATAbits.LATA0 = 1; // Set RA0
l LATB = 0xFF; // Set all of PORTB output

// pins to a logic one

l Reading a I/O port or bit uses the PORT
register
l if (PORTCbits.RC2) // Execute if RC2 = 1
l if (PORTC == 0b11110000) // Check for F0

l Writing to an I/O port or bit should use LAT
register
l LATAbits.LATA0 = 1; // Set RA0
l LATB = 0xFF; // Set all of PORTB output

// pins to a logic one
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PIC18 Peripherals
PORTB : Interrupt on Change

PIC18 PeripheralsPIC18 Peripherals
PORTB : Interrupt on ChangePORTB : Interrupt on Change

l Internal Pull-Ups and Wakeup/Interrupt On
Change feature

l Internal Pull-Ups and Wakeup/Interrupt On
Change feature

I/O Pin

Internal
Pull-up

Port Read Q3

Port Read

Data Bus

Interrupt/Wake-up

DD QQ
ENEN

DD QQ
ENEN

Q1
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PIC18 Peripherals
Timer0

PIC18 PeripheralsPIC18 Peripherals
Timer0Timer0

l 8-bit/16-bit Timer/Counter
l 16-bit Read and Writes

l 8-bit Software Programmable Prescaler
l Internal or External clock select
l Interrupt on overflow from FFh/FFFFh to 00h

l 8-bit/16-bit Timer/Counter
l 16-bit Read and Writes

l 8-bit Software Programmable Prescaler
l Internal or External clock select
l Interrupt on overflow from FFh/FFFFh to 00h

TMR0H:TMR0L
Sync with

internal
clocks

Fosc/4
External

Clock
Input

Set TMR0IF interrupt
flag on Overflow

T0SE
8-bit

Programmable
Prescaler

T0PS2:T0PS0

33
PSA

T0CS
(2 cycle delay)

8-bit Data Bus
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Timer 0 SetupTimer 0 SetupTimer 0 Setup
bit 7 bit 0

TMR0ON T08BIT T0CS T0SE PSA T0PS2 T0PS1 T0PS0T0CONT0CON
TMR0ON Timer 0 On/Off  Control

1 = Enables Timer 0
0 = Stops Timer 0

T08BIT Timer 0 8-bit / 16-bit Select
1 = Timer 0 configured for 8-bit mode
1 = Timer 0 configured for 16-bit mode

T0CS Timer 0 Clock Source Select
1 = Transition on T0CKI pin (counter mode)
0 = Internal Instruction cycle (timer mode)

T0SE Timer 0 Source Edge Select
1 = Increment on High -> Low T0CKI transition
0 = Increment on Low -> High T0CKI transition

PSA Timer 0 Prescaler Asignment
1 = Timer 0 Prescaler is NOT assigned, prescaler bypassed
0 = Timer 0 Prescaler assigned and enabled

T0PS2:T0PS0 Timer 0 Prescaler Selection
111 = 1:256                    011 = 1:16
110 = 1:128                    010 = 1:8
101 = 1:64                      001 = 1:4
100 = 1:32                      000 = 1:2
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PIC18 Peripherals
Timer1 and Timer3

PIC18 PeripheralsPIC18 Peripherals
Timer1 and Timer3Timer1 and Timer3

l 16-bit Timer / Counter
l Consists of two readable and writeable 8-bit

registers
l 16-bit Read / Write mode eliminates hazards

l ÷1, ÷2, ÷4, or ÷8 Prescaler
l Timer, Synchronous or Asynchronous

Counter
l Timer1 can also operate from an external

crystal with its built in oscillator feature.
l Interrupt on overflow from FFFFh to 0000h

l 16-bit Timer / Counter
l Consists of two readable and writeable 8-bit

registers
l 16-bit Read / Write mode eliminates hazards

l ÷1, ÷2, ÷4, or ÷8 Prescaler
l Timer, Synchronous or Asynchronous

Counter
l Timer1 can also operate from an external

crystal with its built in oscillator feature.
l Interrupt on overflow from FFFFh to 0000h
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PIC18 Peripherals
Timer1 and Timer3 (Continued)

PIC18 PeripheralsPIC18 Peripherals
Timer1 and Timer3 (Continued)Timer1 and Timer3 (Continued)

Synchronize
det

T13CLI/
T1OSO

T1OSCEN
Enable

Oscillator
2 SLEEP inputT1OSI

TMR1H

Prescaler
1, 2, 4, 8

TMR1CS

TMR1H
High Byte TMR1L

11

00
FoscFosc/4/4
InternalInternal
ClockClock

T1CKPS1:T1CKPS0T1CKPS1:T1CKPS0

11

00CLRCLR

88

88

88

T1OSCT1OSC

CCP Special Even TriggerCCP Special Even Trigger

Data Bus<7:0>Data Bus<7:0>

88

TMRONTMRON
on/offon/off T1SYNCT1SYNC

SynchronizedSynchronized

Clock InputClock Input
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PIC18FXXX MCU Peripherals
TMR1 as a Real Time Clock

PIC18FXXX MCU PeripheralsPIC18FXXX MCU Peripherals
TMR1 as a Real Time ClockTMR1 as a Real Time Clock

T1OSI

OSC1

PIC18FXXXX

+5V+5V

RR

CC

YY

T1OSO

CC

CC

Preload Preload TMR1H register for faster overflows:TMR1H register for faster overflows:

TMR1H=80h TMR1H=80h →→ 1 second overflow 1 second overflow
TMR1H=C0h TMR1H=C0h →→0.5 second overflow0.5 second overflow

See Application Note AN580 for more info.See Application Note AN580 for more info.
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Timer 1 SetupTimer 1 SetupTimer 1 Setup
bit 7 bit 0

RD16  - T1CKPS1 T1CKPS0 T1OSCEN T1SYNCH TMR1CS TMR1ONT1CONT1CON

RD16 16-bit Read/Write Mode Enable
1 = Enables Read/Write of Timer 1 in one 16-bit operation
0 = Enables Read/Write of Timer 1 in two 8-bit operations

T1CKPS1:T1CKPS0 Timer 1 Input Clock Prescale Selection
11 = 1:8                          01 = 1:2
10 = 1:4                          00 = 1:1

T1OSCEN Timer 1 Oscillator Enable
1 = Timer 1 oscillator is enabled
0 = Timer 1 oscillator is disabled

T1SYNCH Timer 1 External Clock Synchronization Selection
1 = Do NOT synchronize external clock
0 = Synchronize external clock input

TMR1CS Timer 1 Clock Source Selection
1 = External clock from RC0/T1OSC0/T13CKI (counter)
0 = Internal Instruction Cycle

TMR1ON Timer 1 On / Off Selection
1 = Enables Timer 1
0 = Disables Timer 1
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Timer 3 SetupTimer 3 SetupTimer 3 Setup
bit 7 bit 0

RD16 T3CCP2 T3CKPS1 T3CKPS0 T3CCP1 T3SYNCH TMR3CS TMR3ONT3CONT3CON

RD16 16-bit Read/Write Mode Enable
1 = Enables Read/Write of Timer 3 in one 16-bit operation
0 = Enables Read/Write of Timer 3 in two 8-bit operations

T3CCP2:T3CCP1 Timer 3 and Timer 3 CCP Timebase Selection
1X = Timer 3 is Capture/Compare clock source for all CCPs
10 = Timer 3 is Capture/Compare clock source for CCP2,
        Timer 1 is Capture/Compare clock source for CCP1
01 = Timer 1 is Capture/Compare clock source for all CCPs

T3CKPS1:T3CKPS0 Timer 3 Input Clock Prescale Selection
11 = 1:8                          01 = 1:2
10 = 1:4                          00 = 1:1

T3SYNCH Timer 3 External Clock Synchronization Selection
1 = Do NOT synchronize external clock
0 = Synchronize external clock input

TMR3CS Timer 3 Clock Source Selection
1 = External clock from RC0/T1OSC0/T13CKI (counter)
0 = Internal Instruction Cycle

TMR3ON Timer 3 On / Off Selection
1 = Enables Timer 1
0 = Disables Timer 1
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PIC18 Peripherals
Timer2 and Timer4

PIC18 PeripheralsPIC18 Peripherals
Timer2 and Timer4Timer2 and Timer4

l 8-bit Timers with prescaler and postscaler
l TMR2 used as time base for PWM mode

of CCP module
l TMR2/TMR4 are readable & writable
l TMR2/TMR4 increments until they match

period PR2/PR4, then resets to 00h
l TMR2/TMR4 match with PR2/PR4

generates an interrupt through postscaler
l TMR2 can serve as baud clock for MSSP

l 8-bit Timers with prescaler and postscaler
l TMR2 used as time base for PWM mode

of CCP module
l TMR2/TMR4 are readable & writable
l TMR2/TMR4 increments until they match

period PR2/PR4, then resets to 00h
l TMR2/TMR4 match with PR2/PR4

generates an interrupt through postscaler
l TMR2 can serve as baud clock for MSSP
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PIC18 Peripherals
TMR2 Timer: Period Register

PIC18 PeripheralsPIC18 Peripherals
TMR2 Timer: Period RegisterTMR2 Timer: Period Register

TMR2

Comparator

PR2

ResetReset
Prescaler

1, 4, 16

Instruction Instruction 
ClockClock

Postscaler
1:1 to 1:16

Set TMR2IFSet TMR2IF

TOUTPS<3:0>TOUTPS<3:0>

T2CKPS<1:0>T2CKPS<1:0>

Optional SSPOptional SSP
Baud ClockBaud Clock
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Timer 2 SetupTimer 2 SetupTimer 2 Setup

bit 7 bit 0

- TOUTPS3 TOUTPS2 TOUTPS1 TOUTPS0 TMR2ON T2CKPS1 T2CKPS0

T2CON Register FormatT2CON Register Format

TOUTPS<3:0> Select Timer 2 Postscaler:
0000 = 1:1 Postscale
0001 = 1:2 Postscale
….
1111 = 1:16 Postscale

TMR2ON Timer 2 On / Off Control:
0 = Timer 2 is Off
1 = Timer 2 is On

T2CKPS1 Select Timer 2 Prescaller:
00 = Prescaller is 1
01 = Prescaller is 4
1X = Prescaller is 16
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PIC18 Peripherals
TMR4 Timer: Period Register

PIC18 PeripheralsPIC18 Peripherals
TMR4 Timer: Period RegisterTMR4 Timer: Period Register

TMR4

Comparator

PR4

ResetReset
Prescaler

1, 4, 16

Instruction Instruction 
ClockClock

Postscaler
1:1 to 1:16

Set TMR4IFSet TMR4IF

T4OUTPS<3:0>T4OUTPS<3:0>

T4CKPS<1:0>T4CKPS<1:0>
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Timer 4 SetupTimer 4 SetupTimer 4 Setup

bit 7 bit 0

- T4OUTPS3T4OUTPS2T4OUTPS1T4OUTPS0 TMR4ON T4CKPS1 T4CKPS0

T4CON Register FormatT4CON Register Format

T4OUTPS<3:0> Select Timer 4 Postscaler:
0000 = 1:1 Postscale
0001 = 1:2 Postscale
….
1111 = 1:16 Postscale

TMR4ON Timer 4 On / Off Control:
0 = Timer 4 is Off
1 = Timer 4 is On

T4CKPS1 Select Timer 4 Prescaller:
00 = Prescaller is 1
01 = Prescaller is 4
1X = Prescaller is 16
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Timer 2 InterruptsTimer 2 InterruptsTimer 2 Interrupts
bit 7 bit 0

IPEN - - ~RI ~TO ~PD ~POR ~BOR

IPEN Interrupt Priority Level Enable:
1 = Enable Interrupt Priority Levels
0 = Disable Interrupt Priority Levels

RCON RegisterRCON Register

bit 7 bit 0

GIE/GIEH PEIE/GIEL TMR0IE INT0IE RBIE TMR0IF INT0IF RBIF

GIE/GIEH Global Interrupt Enable
IPEN=0                                           IPEN=1
1 = Enable Unmasked Interrupts     1 = Enables High Priority Interrupts
0 = Disable all interrupts                 0 = Disables High Priority Interrupts

PEIE/GIEL Peripheral Interrupt Enable
IPEN = 0                                          IPEN = 1
1 = Enables Unmasked Peripheral   1 = Enables Low Priority Interrupts
      Interrupts
0 = Disables Peripheral Interrupts   0 = Disables Low  Priority Interrupts

INTCON RegisterINTCON Register
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Timer 2 Interrupts ContinuedTimer 2 Interrupts ContinuedTimer 2 Interrupts Continued

bit 7 bit 0

PSPIF ADIF RCIF TXIF SSPIF CCP1IF TMR2IF TMR1IF

TMR2IF Timer 2 to PR2 Match Interrupt Flag
1 = TMR2 to PR2 Match Interrupt Occurred
0 = No TMR2 to PR2 Match Occurred

bit 7 bit 0

PSPIE ADIE RCIE TXIE SSPIE CCP1IE TMR2IE TMR1IE

TMR2IE Timer 2 to PR2 Match Interrupt Enable
1 =  Enable TMR2 to PR2 Match Interrupts
0 = Disable TMR2 to PR2 Match Interrupts

bit 7 bit 0

PSPIP ADIP RCIP TXIP SSPIP CCP1IP TMR2IP TMR1IP

TMR2IP Timer 2 to PR2 Match Interrupt Priority Selection
1 =  TMR2 to PR2 Match Assigned to High Priority Interrupt
0 = TMR2 to PR2 Match  Assigned to Low Priority Interrupt

PIR1 (Peripheral Interrupt Request Flag) RegisterPIR1 (Peripheral Interrupt Request Flag) Register

PIE1 (Peripheral Interrupt Enable) RegisterPIE1 (Peripheral Interrupt Enable) Register

IPR1 (Peripheral Interrupt Priority) RegisterIPR1 (Peripheral Interrupt Priority) Register
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TMR2 Initialization ExampleTMR2 Initialization ExampleTMR2 Initialization Example
l 200 uS / 5 Khz high priority interrupt, 40 Mhz

clock / 10 Mhz instruction clock:
T2CON = 0b00001101; // 4:1 pre 2:1 postscale
PR2 = 249; // 250 count TMR2 period
RCON = 0b10000000; // Enable Priority
PIE1 = 0b00000010; // Enable TMR2 interrupt
IPR1 = 0b00000010; // TMR2 high priority
PIR1bits.TMR2IF = 0; // Optional to eliminate
TMR2 = 0;     // first interrupt
INTCON = 0b10000000; // Turn on interrupts

10,000,000 / (4 (prescale) * 2 (postscale) * 250 (period)) = 5,000
Khz or 200 uS period

l 200 uS / 5 Khz high priority interrupt, 40 Mhz
clock / 10 Mhz instruction clock:
T2CON = 0b00001101; // 4:1 pre 2:1 postscale
PR2 = 249; // 250 count TMR2 period
RCON = 0b10000000; // Enable Priority
PIE1 = 0b00000010; // Enable TMR2 interrupt
IPR1 = 0b00000010; // TMR2 high priority
PIR1bits.TMR2IF = 0; // Optional to eliminate
TMR2 = 0;     // first interrupt
INTCON = 0b10000000; // Turn on interrupts

10,000,000 / (4 (prescale) * 2 (postscale) * 250 (period)) = 5,000
Khz or 200 uS period
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Timer 2 ISR ExampleTimer 2 ISR ExampleTimer 2 ISR Example
l Test and Clear PIR1bits.TMR2IF:
void high_priority_interrupt(void){

if (PIR1bits.TMR2IF){
PIR1bits.TMR2IF = 0;
// execute Timer 2 service code here
}

else if (<other high priority peripherals>){
// Clear other peripheral bits
// execute peripheral service code here
}

else Reset(); // Hit interrupt without valid
}         // flag - illegal condition so restart

l Test and Clear PIR1bits.TMR2IF:
void high_priority_interrupt(void){

if (PIR1bits.TMR2IF){
PIR1bits.TMR2IF = 0;
// execute Timer 2 service code here
}

else if (<other high priority peripherals>){
// Clear other peripheral bits
// execute peripheral service code here
}

else Reset(); // Hit interrupt without valid
}         // flag - illegal condition so restart



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 88

PIC18 Peripherals
CCP Module: PWM Mode

PIC18 PeripheralsPIC18 Peripherals
CCP Module: PWM ModeCCP Module: PWM Mode

l 10-bit resolution,
can trade for speed
(40 Mhz operation)
l 39.06 kHz @ 10-bit
l 156.25 kHz @ 8-bit
l 312.5 kHz @ 7-bit

l 10-bit resolution,
can trade for speed
(40 Mhz operation)
l 39.06 kHz @ 10-bit
l 156.25 kHz @ 8-bit
l 312.5 kHz @ 7-bit

CCPR1L

Slave

Comparator

TMR2

Comparator

PR2

R

S

Q

CCP1CON<5:4>

PeriodPeriod

DCDC

TMR2=PR2 TMR2=CCPR1L

TMR2=PR2
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PIC18 Peripherals
CCP Module: Input Capture Mode

PIC18 PeripheralsPIC18 Peripherals
CCP Module: Input Capture ModeCCP Module: Input Capture Mode

l Captures 16-bit TMR1 value when an event
occurs on CCPx pin:
l Every falling edge
l Every rising edge
l Every 4th rising edge
l Every 16th rising edge

l Capture generates an interrupt

l Captures 16-bit TMR1 value when an event
occurs on CCPx pin:
l Every falling edge
l Every rising edge
l Every 4th rising edge
l Every 16th rising edge

l Capture generates an interrupt
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PIC18 Peripherals
CCP Module: Input Capture Mode (continued)

PIC18 PeripheralsPIC18 Peripherals
CCP Module: Input Capture Mode CCP Module: Input Capture Mode (continued)(continued)

Set Set CCPxIFCCPxIF
Flag BitFlag Bit

CCPxCONCCPxCON<3:0><3:0>

8-bit Data Bus8-bit Data Bus

RCnRCn//CCPxCCPx
PinPin

Capture EnableCapture Enable

Q’sQ’s TMR1LTMR1H

CCPRxLCCPRxLCCPRxH

and

edge detect

Prescaler
÷ 1, 4, 16

8-bit Data Bus8-bit Data Bus
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PIC18 Peripherals
 CCP Module: Output Compare Mode

PIC18 PeripheralsPIC18 Peripherals
  CCP Module: Output Compare ModeCCP Module: Output Compare Mode

l 16-bit CCPRx register value is compared to
TMR1, and on match the CCPx pin is
l Driven High/Low
l Toggled
l Unchanged

l Compare match generates interrupt
l Special event trigger clears TMR1 and can

start A/D conversion

l 16-bit CCPRx register value is compared to
TMR1, and on match the CCPx pin is
l Driven High/Low
l Toggled
l Unchanged

l Compare match generates interrupt
l Special event trigger clears TMR1 and can

start A/D conversion
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PIC18 Peripherals
CCP Module: Output Compare Mode

(continued)

PIC18 PeripheralsPIC18 Peripherals
CCP Module: Output Compare ModeCCP Module: Output Compare Mode

(continued)(continued)

Set Set CCPxIFCCPxIF
Flag BitFlag Bit

TRISC<n>TRISC<n>
Output EnableOutput Enable

8-bit Data Bus8-bit Data Bus

RCnRCn//CCPxCCPx
PinPin

TMR1LTMR1H

8-bit Data Bus8-bit Data Bus

Q S

R

CCPxCONCCPxCON<3:0><3:0>
Mode SelectMode Select

Comparator

CCPRxLCCPRxH

Special EventSpecial Event
TriggerTrigger

OutputOutput
LogicLogic
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CCP1  SetupCCP1  SetupCCP1  Setup
bit 7 bit 0

 -  - DC1B1 DC1B0 CCP1M3 CCP1M2 CCP1M1 CCP1M0CCP1CONCCP1CON

DC1B1:DC1B0 (2) LSBs of PWM Duty Cycle
PWM Mode -> (2) LSBs of a 10-bit Duty Cycle.  The upper (8) bits
(DC19:DC12) of the duty cycle are found in CCPR1L

Capture/Compare Modes -> Unused
CCP1M3:CCP1M0 CCP1 Mode Selection

0000 = Capture/Compare/PWM 1 Disable (resets CCP1 module)
0001 = Reserved
0010 = Compare Mode, Toggle CCP1 output on match
0011 = Reserved
0100 = Capture Mode, every falling edge
0101 = Capture Mode, every rising edge
0110 = Capture Mode, Every 4th rising edge
0111 = Capture Mode, Every 16th rising edge
1000 = Compare Mode, force CCP1 output High on match
1001 = Compare Mode, force CCP1 output Low on match
1010 = Compare Mode, CCP1 output unchanged
1011 = Compare Mode, Trigger Special Event
11XX = PWM Mode

Note: Pin defaults to ‘0’ when capture mode is engagedNote: Pin defaults to ‘0’ when capture mode is engaged
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CCP2  SetupCCP2  SetupCCP2  Setup
bit 7 bit 0

 -  - DC2B1 DC2B0 CCP2M3 CCP2M2 CCP2M1 CCP2M0CCP2CONCCP2CON

DC2B1:DC2B0 (2) LSBs of PWM Duty Cycle
PWM Mode -> (2) LSBs of a 10-bit Duty Cycle.  The upper (8) bits
(DC29:DC22) of the duty cycle are found in CCPR2L

Capture/Compare Modes -> Unused
CCP2M3:CCP2M0 CCP2 Mode Selection

0000 = Capture/Compare/PWM 1 Disable (resets CCP2 module)
0001 = Reserved
0010 = Compare Mode, Toggle CCP2 output on match
0011 = Reserved
0100 = Capture Mode, every falling edge
0101 = Capture Mode, every rising edge
0110 = Capture Mode, Every 4th rising edge
0111 = Capture Mode, Every 16 th rising edge
1000 = Compare Mode, force CCP2 output High on match
1001 = Compare Mode, force CCP2 output Low on match
1010 = Compare Mode, CCP2 output unchanged
1011 = Compare Mode, Trigger Special Event
11XX = PWM Mode

Note: Pin defaults to ‘0’ when capture mode is engagedNote: Pin defaults to ‘0’ when capture mode is engaged
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PIC18 Peripherals
10-bit ADC - Block Diagram

PIC18 PeripheralsPIC18 Peripherals
10-bit ADC - Block Diagram10-bit ADC - Block Diagram

l Up to 16 ch.
l 10-bit ± 1 LSb
l Conversion

during SLEEP
l Internal Or

External
Reference

l Up to 25ksps
l 34 ksps without

channel change

l Up to 16 ch.
l 10-bit ± 1 LSb
l Conversion

during SLEEP
l Internal Or

External
Reference

l Up to 25ksps
l 34 ksps without

channel change

(Input voltage)

VAIN

VREF+
(Reference

voltage)

AVDD 

PCFG2:PCFG0PCFG2:PCFG0

CHS3:CHS0

AN7

AN6

AN5

AN4

AN3/VREF+

AN2/VREF-

AN1

AN0

0111

0110

0101

0100

0011

0010

0001

0000

10-bit 10-bit 
ADCADC

. . .
AN15

VREF-

AVss 



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 96

A/D Setup ADCON0A/D Setup ADCON0A/D Setup ADCON0
bit 7 bit 0

ADCS1 ADCS0 CSH2 CHS1 CHS0 GO_DONE  - ADONADCON0ADCON0

ADCS1:ADCS0

Also

ADCON1 ADCS2

A/D Conversion Clock Select (ADCON1 contains ADCS2)
ADCON1.ADCS2 = 0                         ADCON1.ADCS2 = 1
00 = FOSC/2                                        00 = FOSC/4
01 = FOSC/8                                        00 = FOSC/16
10 = FOSC/32                                      00 = FOSC/64
11 = Frc Internal RC Oscillator            11 = Frc Internal RC Oscillator

CH2:CH0 Analog Channel Select Bits
000 = Channel 0, AN0
001 = Channel 1, AN1
010 = Channel 2, AN2
011 = Channel 3, AN3
100 = Channel 4, AN4
101 = Channel 5, AN5
110 = Channel 6, AN6
111 = Channel 7, AN7

GO_DONE A/D Conversion Status and Conversion Start
1 = Conversion in progress, set this bit to start a conversion
0 = Conversion complete, result in ADRES, cleared by A/D converter

ADON A/D Converter On / Off Selection
1 = Enables A/D Converter
0 = Disables A/D Converter
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A/D Setup ADCON1A/D Setup ADCON1A/D Setup ADCON1
bit 7 bit 0

ADFM ADCS2  -  - PCFG3 PCFG2 PCFG1 PCFG0ADCON1ADCON1

ADFM A/D Result Format Selection
1 = Right Justified. (6) MSBs of ADRESH are ‘0’
0 = Left Justified, (6) LSBs of ADRESL are ‘0’

ADCS2 See ADCON0 for Conversion Clock Selection

PCFG3:PCFG0 Analog Port Configuration Control
<3:0> AN7 AN6 AN5 AN4   AN3     AN2   AN1 AN0 VREF+ VREF- C / R
0000 A      A     A      A         A           A      A      A      VDD     VSS     8 / 0
0001 A      A     A      A     VREF+      A      A      A      AN3      VSS     7 / 1
0010 D      D    D      A         A           A      A      A       VDD     VSS     5 / 0
0011 D      D    D      A     VREF+      A      A      A      AN3       VSS     4 / 1
0100 D      D    D      D         A           D      A      A       VDD     VSS     3 / 0
0101 D      D    D      D     VREF+      D      A      A      AN3      VSS     2 / 1
011x D      D    D      D         D           D      D      D      —           —       0 / 0
1000 A      A     A      A      VREF+ VREF-  A      A      AN3      AN2     6 / 2
1001 D      D     A     A          A           A      A      A      VDD     VSS     6 / 0
1010 D      D     A     A      VREF+      A      A      A      AN3      VSS     5 / 1
1011 D      D     A     A      VREF+  VREF-  A      A     AN3       AN2     4 / 2
1100 D      D     D     A      VREF+  VREF-  A      A     AN3       AN2     3 / 2
1101 D      D     D     D      VREF+  VREF-  A      A     AN3       AN2     2 / 2
1110 D      D     D     D          D          D       D      A     VDD      VSS     1 / 0
1111 D      D     D     D      VREF+  VREF-  D      A     AN3       AN2    1 / 2
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Configuring Inputs as Digital
or Analog

Configuring Inputs as DigitalConfiguring Inputs as Digital
or Analogor Analog

l Pins defined as digital enable the digital
input buffer
l Avoid voltages that reside below VIH and above

VIL to prevent excessive current
l PORT pin reads reflect the pin state

l Pins defined as analog disable the digital
input buffer
l Any voltage below Vdd and above Vss is fine
l PORT pin reads will always be ‘0’

l All pins (D or A) can be digital outputs

l Pins defined as digital enable the digital
input buffer
l Avoid voltages that reside below VIH and above

VIL to prevent excessive current
l PORT pin reads reflect the pin state

l Pins defined as analog disable the digital
input buffer
l Any voltage below Vdd and above Vss is fine
l PORT pin reads will always be ‘0’

l All pins (D or A) can be digital outputs
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PIC18 Peripherals
Analog Comparator Module

PIC18 PeripheralsPIC18 Peripherals
AnalogAnalog Comparator Comparator Module Module

l Two Analog Comparators
l Programmable on-chip voltage reference
l Eight Programmable modes of operation
l Operates in SLEEP mode
l Generates interrupt / wake-up on output

change
l Comparator output pin available

l Two Analog Comparators
l Programmable on-chip voltage reference
l Eight Programmable modes of operation
l Operates in SLEEP mode
l Generates interrupt / wake-up on output

change
l Comparator output pin available

VVREFREF
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PICmicro MCU Peripherals
Analog Comparator Module (continued)

PICmicro MCU PeripheralsPICmicro MCU Peripherals
Analog Analog Comparator Comparator Module Module (continued)(continued)

RA0/AN0RA0/AN0

RA1/AN1RA1/AN1

RA3/AN3RA3/AN3

RA2/AN2RA2/AN2

RA4 Open DrainRA4 Open Drain

C1OUTC1OUT

C2OUTC2OUT

RA0/AN0RA0/AN0

RA1/AN1RA1/AN1

RA3/AN3RA3/AN3

RA2/AN2RA2/AN2

C1OUTC1OUT

C2OUTC2OUT
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l 24 or 32 step sizes
l Internal or External Voltage Reference
l Can be used as a D/A converter
l VREF  can be directed to an output pin

l 24 or 32 step sizes
l Internal or External Voltage Reference
l Can be used as a D/A converter
l VREF  can be directed to an output pin

16 stages

VREN

VRR

8R R R RR

VR3
VR0

16:1 analog muxVREF

8R

•• •

PIC18 Peripherals
Internal VREF: Block Diagram

PIC18 PeripheralsPIC18 Peripherals
Internal VREF: Block DiagramInternal VREF: Block Diagram

Note: Check your device datasheet for availabilityNote: Check your device datasheet for availability
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Comparator  SetupComparator  Comparator  SetupSetup
bit 7 bit 0

C2OUT C1OUT C2INV C1INV CIS CM2 CM1 CM0CMCONCMCON

C2OUT Comparator 2 Output Selection
C2INV = 0:                       C2INV = 1:
1 = C2 Vin+ > C2 Vin-     1 = C2 Vin+ < C2 Vin-
0 = C2 Vin+ < C2 Vin-     0 = C2 Vin+ > C2 Vin-

C1OUT Comparator 1 Output Selection
C1INV = 0:                       C1INV = 1:
1 = C1 Vin+ > C1 Vin-     1 = C1 Vin+ < C1 Vin-
0 = C1 Vin+ < C1 Vin-     0 = C1 Vin+ > C1 Vin-

C2INV Comparator 2 Output Inversion
1 = C2 Output inverted
0 = C2 Output not inverted

C1INV Comparator 1 Output Inversion
1 = C1 Output inverted
0 = C1 Output not inverted

CIS Comparator 1 Input Switch (when CM<2:0> = 110)
1 = C1 Vin- connects to RF5/AN10, C2 Vin- connects to RF3/AN8
1 = C1 Vin- connects to RF6/AN11, C2 Vin- connects to RF4/AN9

CM<2:0> Comparator Mode Selection
See Comparator Mode Figure
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Comparator Reference SetupComparatorComparator Reference Setup Reference Setup
bit 7 bit 0

CVREN CVROE CVRR CVRSS CVR3 CVR2 CVR1 CVR0CVRCONCVRCON

CVREN Comparator Voltage Reference Enable
1 = Enables CVREF Circuit, reference ON
0 = Disables CVREF Circuit, reference OFF

CVROE Comparator Output Enable
1 = CVREF Voltage also driven onto RF5/CVREF pin
0 = CVREF disconnected from RF5/CVREF pin
Note: TRISF<5> must be set to a ‘1’ (input)

CVRR Comparator VREF Source Selection
1 = 0.00 CVRSRC to 0.75 CVRSRC with CVRSRC/24 step
1 = 0.25 CVRSRC to 0.75 CVRSRC with CVRSRC/32 step

CVR3:CVR0 Comparator VREF Value Selection
When CVRR = 1
CVREF = (CVR<3:0>/24) * CVRSRC

When CVRR = 0
CVREF = (0.25 +  (CVR<3:0>/32) )* CVRSRC
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PIC18 Peripherals
Addressable USART (AUSART)

PIC18 PeripheralsPIC18 Peripherals
Addressable USART (AUSART)Addressable USART (AUSART)

l Full-duplex Asynchronous Or Half-duplex
Synchronous

l 9-bit Addressable mode
l Double-buffered transmit and receive

buffers
l Separate transmit and receive interrupts
l Dedicated baud rate generator
l Max bit rates @ 40MHz

l Asynchronous: 625 kbps / 2.5 Mbps
l Synchronous: 10 Mbps

l Full-duplex Asynchronous Or Half-duplex
Synchronous

l 9-bit Addressable mode
l Double-buffered transmit and receive

buffers
l Separate transmit and receive interrupts
l Dedicated baud rate generator
l Max bit rates @ 40MHz

l Asynchronous: 625 kbps / 2.5 Mbps
l Synchronous: 10 Mbps
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PIC18 Peripherals
USART Block Diagram
PIC18 PeripheralsPIC18 Peripherals
USART Block DiagramUSART Block Diagram

SPBRGSPBRG

OERROERR

RCIFRCIF

TXIFTXIF

Interrupt

FOSC / 4

TXIE TX9

TX9D

TXDATA

TXCLK

RX9D
RX9

RCIE

RCCLK

RXDATA

TXEN   SYNC
SREN   CSRC
CREN

RC6/TX/CK

SPEN

RC7/RX/DT

TO RC6, RC7 
I/O Port Logic

Baud Rate
Clock

ADDEN

TSRTSR

FERRFERR

RSRRSR

TXREGTXREG

RCREGRCREG
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UART Tx SetupUART UART TxTx Setup Setup
bit 7 bit 0

CVREN TX9 TXEN SYNC  - BRGH TRMT TX9DTXSTATXSTA

CSRC Clock Source Selection (synch mode only)
1 = Master mode, clock generated by internal BRG
0 = Slave mode, clock derived from external

TX9 9-bit  / 8-bit Mode Transmission Selection
1 = 9-bit Transmission Format
0 = 8-bit Transmission Format

TXEN Transmit Enable (overridden by SREN/CREN in SYNC mode)
1 = Transmitter Enabled
0 = Transmitter Disabled

SYNC Synchronous / Asynchronous Selection
1 = Synchronous Mode
0 = Asynchronous Mode

BRGH High / Low Baud Rate Selection
1 = High Speed Baud Rate, FOSC / 16
0 = Low Speed Baud Rate, FOSC / 64

TRMT Transmit Shift Register Status
1 = Transmit Shift Register Empty
0 = Transmit Shift Register Full

TX9D 9th Bit of Transmit Data (valid only in 9-bit mode)
Written before TXREG, used for parity or address/data
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UART Rx SetupUART Rx SetupUART Rx Setup
bit 7 bit 0

SPEN RXD SREN CREN ADDEN FERR OERR RX9DRCSTARCSTA

SPEN Serial Port Enable
1 = Serial Port Enabled, Uses RX and TX as serial port pins
0 = Serial Pore Disabled, RX and TX general purpose I/Os

RX9 9-bit  / 8-bit Mode Reception Selection
1 = 9-bit Reception Format
0 = 8-bit Reception Format

SREN Single Receive Enable (Synchronous Mode Only)
1 = Enable a Single Receive
0 = Disable Single Receive, cleared when reception completed

CREN Continuous Receive Enable
1 = Enables Receiver; Continuous Reception in Synch mode, overriding SREN
0 = Disables Receiver in Asynchronous Mode, SREN controls Synch mode

ADDEN Address Detect Enable
1 = Enables 9-bit Address Detection, Interrupt and load RCREG when bit 9 is ‘1’
0 = Disables Address Detection, all bytes received

FERR Framing Error
1 = Framing Error Occurred in this byte, clear by read RCREG + receive next byte
0 = No Framing Error

OERR Overrun Error
1 = Overrun Error, cleared by clearing CREN
0 = No Overrun Error

RX9D 9th Bit of Received Data (valid only in 9-bit mode)
Read before TXREG, used for parity or address/data
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UART Baud Rate GeneratorUART Baud Rate GeneratorUART Baud Rate Generator

l Separate Resource does not use any timers
l Divides (FOSC / 16 or 64) by 1 to 256
l Separate Resource does not use any timers
l Divides (FOSC / 16 or 64) by 1 to 256

Baud Rate = Baud Rate = 
FOSCFOSC

64 * (SPBRG + 1) 64 * (SPBRG + 1) 

Low Speed ModeLow Speed Mode
TXSTAbitsTXSTAbits.BRGH = 0.BRGH = 0

Baud Rate = Baud Rate = 
FOSCFOSC

16 * (SPBRG + 1) 16 * (SPBRG + 1) 

High Speed ModeHigh Speed Mode
TXSTAbitsTXSTAbits.BRGH = 1.BRGH = 1
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UART BuffersUART BuffersUART Buffers

l Load TXREG with byte to be transmitted
l Buffer empty ONLY when PIR1bits.TXIF is set

l Read received byte from RCREG
l Received data ONLY when PIR1bits.RCIF is

set

void putchar(value){
while (PIR1bits.TXIF == 0);// Wait for empty FIFO
TXREG = value;
}

l Load TXREG with byte to be transmitted
l Buffer empty ONLY when PIR1bits.TXIF is set

l Read received byte from RCREG
l Received data ONLY when PIR1bits.RCIF is

set

void putchar(value){
while (PIR1bits.TXIF == 0);// Wait for empty FIFO
TXREG = value;
}
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PIC18 Peripherals
Master Synchronous Serial Port

PIC18 PeripheralsPIC18 Peripherals
MMaster aster SSynchronous ynchronous SSerial erial PPortort

l Operates in either SPI™ or I2C™ mode
l SPI Mode

l Programmable baud rate
l Maximum baud rates (@ 40MHz)

l Master: 10 Mbps
l Slave: 2.5 Mbps Single Byte Tx

l All four SPI modes supported (0,0;0,1;1,0;1,1)

l I2C Mode
l Supports standard (100kHz), fast (400kHz), and Microchip’s

1MHz I2C standards
l Hardware Master/Slave implementation

l Operates in either SPI™ or I2C™ mode
l SPI Mode

l Programmable baud rate
l Maximum baud rates (@ 40MHz)

l Master: 10 Mbps
l Slave: 2.5 Mbps Single Byte Tx

l All four SPI modes supported (0,0;0,1;1,0;1,1)

l I2C Mode
l Supports standard (100kHz), fast (400kHz), and Microchip’s

1MHz I2C standards
l Hardware Master/Slave implementation

SPI is a trademark of Motorola SemiconductorSPI is a trademark of Motorola Semiconductor
II22C is a trademark of Philips SemiconductorsC is a trademark of Philips Semiconductors
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MSSP SPI Mode SetupMSSP SPI Mode SetupMSSP SPI Mode Setup
bit 7 bit 0

SMP CKE D_A P S R_W UA BFSSPSTATSSPSTAT

SMP Input Sample Control
1 = Input sampled at the end of data output time
0 = Input sampled at the middle of data output time

CKE Clock Edge Selection
If CKP = 0                                                     If CKP = 0
1 = Data transmitted on SCLK rising edge   1 = Data transmitted on SCLK falling edge
0 = Data transmitted on SCLK falling edge  0 = Data transmitted on SCLK rising edge

D_A Data / Address bit used ONLY in I2C mode, unused in SPI mode

P Stop bit used ONLY in I2C mode, unused in SPI mode

S Start bit used ONLY in I2C mode, unused in SPI mode

R_W Read / Write bit used ONLY in I2C mode, unused in SPI

UA Update Address bit used ONLY in I2C mode, unused in SPI mode

BF Buffer Full (Receive mode only)
1 = Receive complete, SSBUF is full
0 = Receive not complete, SSBUF is empty
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MSSP SPI Mode Setup Cont.MSSP SPI Mode Setup MSSP SPI Mode Setup ContCont..
bit 7 bit 0

WCOL SSPOV SSPEN CKP SSPM3 SSPM2 SSPM1 SSPM0SSPCON1SSPCON1

WCOL Write Collision Detection (Master Mode Only – Must be cleared in software)
1 = The SSPBUF register was written while still transmitting a previous word
0 = No write collision

SSPOV Receive Overflow Indicator (Slave Mode Only – Must be cleared in software)
1 = A new byte has been received from the master before the previous byte was read from
SSPBUF.   In case of overflow, the data is lost and SSPBUF must be read to clear overflow
condition.   Slave transmitter applications should also read SSBUF after each byte
0 = No Slave Receive Overflow

SSPEN Synchronous Serial Port Enable
1 = Enables serial port and configures SCK, SDO, SDI and SS as serial port pins
0 = Disables serial port; allows SCK, SDO SDI and SS to be used as general purpose I/Os

SCP Clock Polarity Selection
1 = Idle state for clock is a high level
0 = Idle state for clock is a low level

SSPM3:SSPM0 Synchronous Serial Port Mode Selection
0101 = SPI Slave Mode, Clock – SCLK, SS Control Disabled, SS is GPIO
0100 = SPI Slave Mode, Clock = SCLK, SS Control enabled
0011 = SPI Master Mode, Clock = Timer 2 Output / 2
0010 = SPI Master Mode, Clock = FOSC/64
0001 = SPI Master Mode, Clock = FOSC/16
0000 = SPI Master Mode, Clock = FOSC/4
NOTE: Other combinations used in I2C mode or reserved
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PICmicro MCU Peripherals
Parallel Slave Port

PICmicro MCU PeripheralsPICmicro MCU Peripherals
Parallel Slave PortParallel Slave Port

l Provides an 8-bit interface such that the PICmicro
MCU may be used as a peripheral to a
microprocessor

l Three I/O on PORTE act as Chip Select, Read, and
Write lines

l PORTD is the data bus
l Separate read and write interrupts available
l Currently available on

most 40-pin,
14-bit core devices

l Provides an 8-bit interface such that the PICmicro
MCU may be used as a peripheral to a
microprocessor

l Three I/O on PORTE act as Chip Select, Read, and
Write lines

l PORTD is the data bus
l Separate read and write interrupts available
l Currently available on

most 40-pin,
14-bit core devices

DSPDSP
oror

MPUMPU 8-bit Data Bus8-bit Data Bus

RD, WR, CSRD, WR, CS

P
IC

m
icro

P
IC

m
icro

M
C

U
M

C
U
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PICmicro MCU Peripherals
Parallel Slave Port:  MCU Interface
PICmicroPICmicro  MCUMCU Peripherals Peripherals
Parallel Slave Port:  MCU InterfaceParallel Slave Port:  MCU Interface

l Direct interface to 8-bit microprocessor
data bus

l Asynchronous operation (to external world)
l Interrupt generated on external read or write

operation on parallel port
l Uses Port D and Port E

l Port D: Data bus
l Port E: Control signals (read, write, and

chip select)

l Direct interface to 8-bit microprocessor
data bus

l Asynchronous operation (to external world)
l Interrupt generated on external read or write

operation on parallel port
l Uses Port D and Port E

l Port D: Data bus
l Port E: Control signals (read, write, and

chip select)
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PICmicro MCU Peripherals
Parallel Slave Port: Block Diagram
PICmicroPICmicro  MCUMCU Peripherals Peripherals
Parallel Slave Port: Block DiagramParallel Slave Port: Block Diagram

Data b us

WR
PORT

RD

RDx

QD

CK

EN

Q D

EN
PORT

pin

One bit of PORTD

Set interr upt ½ag
PSPIF  (PIR1<7>)

Read

Chip Select

Write

RD

CS

WR

Note:  I/O pin has protection diodes to VDD  and VSS .

TTL

TTL

TTL

TTL
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Parallel Slave Port SetupParallel Slave Port SetupParallel Slave Port Setup
bit 7 bit 0

IBF OBF IBOV PSPMODE  - TRISE2 TRISE1 TRISE0TRISETRISE

IBF Input Buffer Full Status
1 = A word has been received from the master  into PORTD and is waiting to be read
0 = No word has been received from the master

OBF Output Buffer Full Status
1 = The PORTD output buffer still holds a previously written word
0 = The PORTD output buffer has been read by the master and is now empty

IBOV Input buffer Overflow Detect Status (Must Be Cleared In Software)
1 = The master wrote a byte before a previously written byte was read from PORTD
0 = No write overflow occurred

PSPMODE Parallel Slave Port Mode Selection
1 = Enable Parallel Slave Port
0 = Disable Parallel Slave Port, PORTD and PORTE General Purpose I/Os

TRISE2:TRISE0 PORTE, Pins RE2:RE0 Direction Control
1 = RE x set to input
0 = RE x set to output
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Special FeaturesSpecial FeaturesSpecial Features
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New Oscillator Modes
PIC18F452 Oscillator Block Diagram

New Oscillator ModesNew Oscillator Modes
PIC18F452 Oscillator Block DiagramPIC18F452 Oscillator Block Diagram

Note:  FOSC0, FOSC1, FOSC2, and OSCSEN bits are in CONFIG1H  (300001h)

Fuse options select 

T13CKI/T1OSO

T1OSI

Fosc = 32 kHz

32 kHz Oscillator

To 
Timer1/Timer3

 input
M

U
X

oscillator modes

  Loop  
Filter

OSCOUT

OSCIN

PLL Enable

FIN

FOUT

Phase
Comparator Cvco

HS Osc

 VCO 

SYSCLK

OSCIN

Ext RC 
and 

Crystal 
Osc

 Feedback Divider
   3      2       1      0 
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PIC18 Special Features
Programmable Low Voltage Detect

PIC18 Special FeaturesPIC18 Special Features
Programmable Low Voltage DetectProgrammable Low Voltage Detect

l Provides “Early Warning”
l Programmable internal or external reference

l Up to 14 internal reference voltages (2 - 4.77V)

l Operates during SLEEP
l Low Voltage condition wakes-up/interrupts

MCU

l Software Controlled enable/disable
l Useful for low power applications

l Provides “Early Warning”
l Programmable internal or external reference

l Up to 14 internal reference voltages (2 - 4.77V)

l Operates during SLEEP
l Low Voltage condition wakes-up/interrupts

MCU

l Software Controlled enable/disable
l Useful for low power applications
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PIC18 Special Features
Programmable Brown-Out RESET

PIC18 Special FeaturesPIC18 Special Features
Programmable Brown-Out RESETProgrammable Brown-Out RESET

l Monitors operating voltage range
l Resets MCU when Vdd is below reference

voltage
l Deasserts RESET after Vdd is above reference

voltage
l Programmable internal reference

l Up to 4 voltages (2.0, 2.7, 4.2, 4.5)

l Enabled via Configuration register

l Monitors operating voltage range
l Resets MCU when Vdd is below reference

voltage
l Deasserts RESET after Vdd is above reference

voltage
l Programmable internal reference

l Up to 4 voltages (2.0, 2.7, 4.2, 4.5)

l Enabled via Configuration register
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PIC18 Special Features
Watchdog Timer (WDT)

PIC18 Special FeaturesPIC18 Special Features
Watchdog Timer (WDT)Watchdog Timer (WDT)

l Recovers from software malfunction
l Resets MCU if not attended on-time

l Software must clear it periodically (CLRWDT)

l Programmable period
l 18 ms to 3.0 s typical

l Configuration controlled postscaler
l Enabled via Configuration register or

Software

l Recovers from software malfunction
l Resets MCU if not attended on-time

l Software must clear it periodically (CLRWDT)

l Programmable period
l 18 ms to 3.0 s typical

l Configuration controlled postscaler
l Enabled via Configuration register or

Software
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Watchdog Enhancements
Block Diagram

Watchdog EnhancementsWatchdog Enhancements
Block DiagramBlock Diagram

WTD Time-out

WDT Timer Postscaler

SWDTEN
WDTEN
Configuration Bit

Reset
CLRWDT
Instruction

l The watchdog can be programmed on and off in software
l If Configuration bit WDTE = 1, the WDT cannot be

turned off in software
l If Configuration bit WDTE = 0, the software

watchdog bit SWDTEN, can be used to
enable/disable the WDOG timer

l This is useful for applications that want to
conserve power by turning off the WDT while in
sleep or executing non-critical application code

l The watchdog can be programmed on and off in software
l If Configuration bit WDTE = 1, the WDT cannot be

turned off in software
l If Configuration bit WDTE = 0, the software

watchdog bit SWDTEN, can be used to
enable/disable the WDOG timer

l This is useful for applications that want to
conserve power by turning off the WDT while in
sleep or executing non-critical application code
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PIC18 Special Features
In-Circuit Serial ProgrammingTM
PIC18 Special FeaturesPIC18 Special Features

In-Circuit Serial In-Circuit Serial ProgrammingProgrammingTMTM

l Enhanced In-System Programming Method
l Uses only two pins to send/receive data
l Non-intrusive to normal operation
l Advantages of ICSP™ programming mode

l Reduce cost of field upgrades
l Calibrate and Serialize Systems

during manufacturing
l Reduce handling: Important for

DIE and fine lead package

l Enhanced In-System Programming Method
l Uses only two pins to send/receive data
l Non-intrusive to normal operation
l Advantages of ICSP™ programming mode

l Reduce cost of field upgrades
l Calibrate and Serialize Systems

during manufacturing
l Reduce handling: Important for

DIE and fine lead package

MCLR/VPP

VDD VDD

VPP

VSS VSS

I/O 1 Clock
I/O 2 Data
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PIC18FXXX Product Line CardPIC18FXXX Product Line CardPIC18FXXX Product Line Card
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PICmicro 28/40 Pin Device
Compatibility

PICmicro PICmicro 28/40 Pin Device28/40 Pin Device
CompatibilityCompatibility
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Future ProductsFuture ProductsFuture Products
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PICmicroPICmicro® Microcontroller Microcontroller
Development ToolsDevelopment Tools

ProjectProject
ManagerManager

Built-in Built-in 
EditorEditor

Source LevelSource Level
DebuggerDebugger

MPASMMPASM™™
AssemblerAssembler

C CompilersC Compilers
•• MPLABMPLAB C17 C17
•• MPLABMPLAB C18 C18

LanguagesLanguages ProgrammersProgrammers

MPLABMPLABSIMSIM
SimulatorSimulator

SimulatorsSimulators

MPLABMPLABICEICE
      In-Circuit EmulatorIn-Circuit Emulator

•• ICE2000 ICE2000

Emulators/Emulators/
DebuggersDebuggers

Third PartyThird Party
•• ProgrammersProgrammers
•• EmulatorsEmulators
•• CompilersCompilers
•• Development BoardsDevelopment Boards
•• Training ToolsTraining Tools

Other ToolsOther Tools

MPLABMPLAB

Integrated Development EnvironmentIntegrated Development Environment

PICSTARTPICSTART

PlusPlus
Development ProgrammerDevelopment Programmer

PRO MATEPRO MATEIIII
Production Quality Production Quality 

ProgrammerProgrammer

MPLABMPLABICDICD
In-Circuit Debugger In-Circuit Debugger 

  Object LibrarianObject Librarian
MPLIBMPLIB™™

MPLINKMPLINK™™
Object LinkerObject Linker
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New MPLAB® V6.00
Native Windows / 32-Bit implementation

New MPLABNew MPLAB® ® V6.00V6.00
Native Windows / 32-Bit implementation

l Color Coded Context Sensitive Text Editor
l Relocatable projects with Win/32 long file names
l Automatic C variable sizing in watch windows
l Arrays and Structures views in watch windows
l Modify file registers within watch windows
l Breakpoint settings persistence
l Improved MPLAB-SIM Simulator speed
l Advanced project manager
l Full Speed USB interface for MPLAB-ICD2
l MPLAB-ICE2000 emulator PROMATE-II programmer

and PICSTART PLUS programmer support

l Color Coded Context Sensitive Text Editor
l Relocatable projects with Win/32 long file names
l Automatic C variable sizing in watch windows
l Arrays and Structures views in watch windows
l Modify file registers within watch windows
l Breakpoint settings persistence
l Improved MPLAB-SIM Simulator speed
l Advanced project manager
l Full Speed USB interface for MPLAB-ICD2
l MPLAB-ICE2000 emulator PROMATE-II programmer

and PICSTART PLUS programmer support
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MPLAB® V6.10 Release
New features planned for this fall..
MPLABMPLAB® ® V6.10 ReleaseV6.10 Release
New features planned for this fall..New features planned for this fall..

l Multi- language tools capability with Standardized 3rd party
Compiler Interface (Hi-Tech, IAR, CCS)

l V6.00 supports PIC18C/FXXXX and dsPIC30F devices and
MPLAB C18 compilers only

l V6.10 adds support for all PIC12/16C/FXXX and 3rd party
compilers like Hi-Tech, IAR and CCS

l Multi- language tools capability with Standardized 3rd party
Compiler Interface (Hi-Tech, IAR, CCS)

l V6.00 supports PIC18C/FXXXX and dsPIC30F devices and
MPLAB C18 compilers only

l V6.10 adds support for all PIC12/16C/FXXX and 3rd party
compilers like Hi-Tech, IAR and CCS
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MPLAB-C18 C CompilerMPLAB-C18 C CompilerMPLAB-C18 C Compiler

l ANSI compatible Microchip developed
compiler for PIC18FXXX devices

l Compatible with MPASM assembler,
MPLINK linker and MPLIB librarian
l Compatible at object level
l Supports relocatable objects
l Effortlessly mix C and Assembly source files

l Full Source Level Debugging using MPLAB V6.0
l Free 30 day copies available on the web

www.microchip.com

l ANSI compatible Microchip developed
compiler for PIC18FXXX devices

l Compatible with MPASM assembler,
MPLINK linker and MPLIB librarian
l Compatible at object level
l Supports relocatable objects
l Effortlessly mix C and Assembly source files

l Full Source Level Debugging using MPLAB V6.0
l Free 30 day copies available on the web

www.microchip.com
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Compiler, Assembler and
Linker

Compiler, Assembler andCompiler, Assembler and
LinkerLinker

LAB1.C

MPLAB-C18

LAB1.O

DELAY.C

MPLAB-C18

DELAY.O

LCD.C

MPLAB-C18

LCD.O

CONFIG.ASM

MPASM

CONFIG.O

MPLINK

LAB1.HEX LAB1.COF LAB1.COD

Intel Hex 32 Symbolic Debugging Legacy Symbolic Debugging

Compiler 

or

Assembler

P18F452.LKR

Linker Script

Linker <libraries>.LIB

Standard and Peripheral
Libraries

Machine HEX code Information Information
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In Circuit Debugger MPLAB-ICD 2

l Full Speed 12 Mb/s USB PC
interface

lPowered supplied by USB port
l In System Serial Programmer
l In Circuit Real-time (C and

Assembly) Source Code Debugger
Supporting:

lSingle step through C and
Assembly
lExamine and Modify all internal
RAM and Peripheral Registers
lProgram Memory Breakpoint
lFull speed code execution with
target clock and peripherals

DV164005  ICD 2 Module                            $159 USD
DV164006  ICD 2 Module + PICDEM II+ $209 USD 
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MPLAB ICD 2 OptionsMPLAB ICD 2 OptionsMPLAB ICD 2 Options

l Programmer board enables use as a
universal PICmicro programmer
l Can replace your PICSTART PLUS programmer

l RS-232 interface and power supply for
legacy PCs without USB support

l Programmer board enables use as a
universal PICmicro programmer
l Can replace your PICSTART PLUS programmer

l RS-232 interface and power supply for
legacy PCs without USB support

DV162049 ICD  2 Universal Programming Module           $39 USD
DV164007  ICD 2 Module + RS232 + Power Supply          $188 USD 
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MPLAB-ICE 2000
In Circuit Emulator

MPLAB-ICE 2000
In Circuit Emulator

l Unlimited Program
Breakpoints

l Trigger and Break on Data
Memory Read / Write

l (4) Individual Trigger
Events

l Programmable System
Oscillator 32Khz ~ 25 Mhz

l Code Coverage
l Pass Counter
l 32K Trace Buffer traces

program and data
memory
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MPLAB ICE 2000 ConnectivityMPLAB ICE 2000 ConnectivityMPLAB ICE 2000 Connectivity

l Universal pod supports PIC12/16/18
l Processor module supports device family
l Device Adapter supports package type
l Transition Sockets support Surface

Mount
l Parallel Port PC interface
l ~$2,000 for complete system

l Universal pod supports PIC12/16/18
l Processor module supports device family
l Device Adapter supports package type
l Transition Sockets support Surface

Mount
l Parallel Port PC interface
l ~$2,000 for complete system
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MPLAB V6.0, MPLAB-ICD-II
PIC18FXXX Hands On  Exercises

MPLAB V6.0, MPLAB-ICD-IIMPLAB V6.0, MPLAB-ICD-II
PIC18FXXX Hands On  ExercisesPIC18FXXX Hands On  Exercises



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 140

Hands On Exercises AgendaHands On Exercises AgendaHands On Exercises Agenda

l Lab 1 - Install MPLAB 6.0, MPLAB-ICD II,
MPLAB-C18, Connect Demo board
l Create Project, Compile, Download Code,

Get First Demo Up and Running, MPLAB
basics

l Lab 2 - Develop and Debug a traffic light
l Lab 3 - Develop and Debug A/D sampling ISR
l Lab 4 - Run DFT() algorithm on A/D Sampling

Buffer results and pass array to display routine
for graphing

l Lab 5 - Extra credit- Add Automatic Gain
Control using SPI controlled Digital POT

l Lab 1 - Install MPLAB 6.0, MPLAB-ICD II,
MPLAB-C18, Connect Demo board
l Create Project, Compile, Download Code,

Get First Demo Up and Running, MPLAB
basics

l Lab 2 - Develop and Debug a traffic light
l Lab 3 - Develop and Debug A/D sampling ISR
l Lab 4 - Run DFT() algorithm on A/D Sampling

Buffer results and pass array to display routine
for graphing

l Lab 5 - Extra credit- Add Automatic Gain
Control using SPI controlled Digital POT
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Audio Spectrum
Analyzer Board
Audio SpectrumAudio Spectrum
Analyzer BoardAnalyzer Board

North /
South Switch

and Gain
Adjust

East / West
Switch and
Gain Adjust

A/D Channel
Selection MIC,

RCA, POT
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Schematics, Page 1Schematics, Page 1Schematics, Page 1
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Schematics, Page 2Schematics, Page 2Schematics, Page 2
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Schematics, Page 3Schematics, Page 3Schematics, Page 3
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Install MPLAB V6.00, MPLAB-
C18, MPLAB-ICD-II

Install MPLAB V6.00, MPLAB-Install MPLAB V6.00, MPLAB-
C18, MPLAB-ICD-IIC18, MPLAB-ICD-II

l Step 1: Connect USB cable of MPLAB ICD 2
l Step 2: Connect power supply to Workshop

target board
l Step 3: Install MPLAB IDE, ICD 2, C18

l •  Run “MPLIDEV6.EXE” (MPLAB/32 IDE)
l •  Run “MPICD2.EXE” (MPLAB ICD 2)
l •  Re-boot after MPLAB IDE detect ICD 2
l •  Run “MCC18V20.EXE” (MPLAB C18)

l Step 1: Connect USB cable of MPLAB ICD 2
l Step 2: Connect power supply to Workshop

target board
l Step 3: Install MPLAB IDE, ICD 2, C18

l •  Run “MPLIDEV6.EXE” (MPLAB/32 IDE)
l •  Run “MPICD2.EXE” (MPLAB ICD 2)
l •  Re-boot after MPLAB IDE detect ICD 2
l •  Run “MCC18V20.EXE” (MPLAB C18)
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Install Workshop FilesInstall Workshop FilesInstall Workshop Files

l Step 4: Install workshop files
l • Run Workshop.bat, installing workshop files

in default directory C:/workshop

l Step 5: Create your first Project
l Verify MPLAB C18 Installation and Paths
l Create Project, add source files
l Build Project
l Download HEX to target, Run

l LCD display should show a message...

l Step 4: Install workshop files
l • Run Workshop.bat, installing workshop files

in default directory C:/workshop

l Step 5: Create your first Project
l Verify MPLAB C18 Installation and Paths
l Create Project, add source files
l Build Project
l Download HEX to target, Run

l LCD display should show a message...
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Setting Up MPLAB V6.0Setting Up MPLAB V6.0Setting Up MPLAB V6.0

l Configure -> Select Device -> PIC18F452l Configure -> Select Device -> PIC18F452

l Debugger -> Select
Tool -> MPLAB-ICD 2

l Debugger -> Select
Tool -> MPLAB-ICD 2
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Configuring MPLAB ICD 2Configuring MPLAB ICD 2Configuring MPLAB ICD 2

l Status Tab - Check
“Automatically connect
at startup”

l Status Tab - Check
“Automatically connect
at startup”

l Program Tab - Press “Full
Range” button and end
address set to 0x7DBF

l Program Tab - Press “Full
Range” button and end
address set to 0x7DBF

l Debugger -> Settingsl Debugger -> Settings
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Verify Compiler InstallationVerify Compiler InstallationVerify Compiler Installation

l Project -> Set Language Tool Locationsl Project -> Set Language Tool Locations

MPLAB-C18 Compiler located in C:\mcc18\bin\mcc18.exe MPLINK Linker located in C:\mcc18\bin\mplink.exe
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Project CreationProject CreationProject Creation
l Project -> New

l Name project lab1 and place in c:\workshop

l Project -> New
l Name project lab1 and place in c:\workshop

l Project -> Insert Files
l Add config.asm,

delay.c, lab1.c,
lcd.c located in the
c:\workshop directory

l Hold CTL to add files

l Project -> Insert Files
l Add config.asm,

delay.c, lab1.c,
lcd.c located in the
c:\workshop directory

l Hold CTL to add files
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Add Compiler Path
Information

Add Compiler PathAdd Compiler Path
InformationInformation

l Project -> Settings
Configure Paths
Include -> c:\mcc18\h
Library -> c:\mcc18\lib
Linker -> c:\mcc18\lkr
Output -> Blank…

l Expect this to be
automated in future
release

l Project -> Settings
Configure Paths
Include -> c:\mcc18\h
Library -> c:\mcc18\lib
Linker -> c:\mcc18\lkr
Output -> Blank…

l Expect this to be
automated in future
release
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Add Your Linker ScriptAdd Your Linker ScriptAdd Your Linker Script

l Project -> Insert Files -> Select Linker Script
C:\mcc18\lkr\p18F452i.lkr

l Project -> Insert Files -> Select Linker Script
C:\mcc18\lkr\p18F452i.lkr

l Your Project Should
Look Like This...

l Your Project Should
Look Like This...
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Build Your ProjectBuild Your ProjectBuild Your Project
l Project->Build All

l MPLAB-C18 runs on all C files in output window
l MPASM assembler runs on config.asm file
l MPLINK linker links all files together and creates

HEX output

l Project->Build All
l MPLAB-C18 runs on all C files in output window
l MPASM assembler runs on config.asm file
l MPLINK linker links all files together and creates

HEX output
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Download Code to Target and
Run…..

Download Code to Target andDownload Code to Target and
Run…..Run…..

l Debugger -> Download to Targetl Debugger -> Download to Target

l Debugger -> Run
l You should see a “Welcome” message on

the LCD display

l Debugger -> Run
l You should see a “Welcome” message on

the LCD display
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Creating Watch WindowsCreating Watch WindowsCreating Watch Windows

l View->Watch,  add countl View->Watch,  add count

l Right Click count and
change Watch
Properties Format to
decimal and hit OK

l Right Click count and
change Watch
Properties Format to
decimal and hit OK

l Debugger -> Haltl Debugger -> Halt
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Configuration Bit Settings
Window

Configuration Bit SettingsConfiguration Bit Settings
WindowWindow

l Configure -> Configuration Bits
l Automatically Initialized by config.asm if

included in your project

l Configure -> Configuration Bits
l Automatically Initialized by config.asm if

included in your project
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Setting BreakpointsSetting BreakpointsSetting Breakpoints

l Double Click on lab1.c in Project Window
l Find lcd_putch(‘D’); select and click this statement with right

mouse button to set a breakpoint there

l Double Click on lab1.c in Project Window
l Find lcd_putch(‘D’); select and click this statement with right

mouse button to set a breakpoint there



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 158

Modifying Watch ValuesModifying Watch ValuesModifying Watch Values

l Hit Debugger -> Run see debugger halt at
lcd_putdec

l “Count = <value>”on the LCD should be the
same as count in your watch window

l Place your cursor over the watch value, type
a new number and re-run

l See new value
on LCD display

l Hit Debugger -> Run see debugger halt at
lcd_putdec

l “Count = <value>”on the LCD should be the
same as count in your watch window

l Place your cursor over the watch value, type
a new number and re-run

l See new value
on LCD display
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Single SteppingSingle SteppingSingle Stepping

l Debugger->Step Into
l MPLAB automatically opens lcd.c and steps

into lcd_putch()….

l Debugger->Step Into
l MPLAB automatically opens lcd.c and steps

into lcd_putch()….
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Tool BarsTool BarsTool Bars

l Most common debugger functions are
available on the toolbar

l Most common debugger functions are
available on the toolbar

Run

Halt

Step

Step

Over

Reset

Program

Target

Reset

and 

Connect
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Lab 2 Traffic LightLab 2 Traffic LightLab 2 Traffic Light

l Traffic Light has (4) states:
State North / South East / West
EW_GREEN RED GREEN
EW_YELLOW RED YELLOW
NS_GREEN GREEN RED
NS_YELLOW YELLOW RED

l Traffic Light has (4) states:
State North / South East / West
EW_GREEN RED GREEN
EW_YELLOW RED YELLOW
NS_GREEN GREEN RED
NS_YELLOW YELLOW RED

N/S = North / SouthN/S = North / South

E/W = East / WestE/W = East / West
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Lab 2: Traffic Light LogicLab 2: Traffic Light LogicLab 2: Traffic Light Logic
NS_GREEN

Wait 1.5 Seconds

EW_SWITCH = 1?

EW_SWITCH = 0
STATE = NS_YELLOW

update_state = 1

NS_YELLOW
Wait 1.5 Seconds

STATE = EW_GREEN
update_state = 1

Yes

No

EW_GREEN
Wait 1.5 Seconds

NS_SWITCH = 1?

NS_SWITCH = 0
STATE = EW_YELLOW

update_state = 1

EW_YELLOW
Wait 1.5 Seconds

STATE = NS_GREEN
update_state = 1

Yes

No
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Lab 2:Traffic Light
Implementation

Lab 2:Traffic LightLab 2:Traffic Light
ImplementationImplementation

l Project -> Open -> lab2.mcp
l Edit lab2.c and add the state transition code as follows:
switch(state){

case EW_GREEN: Delay100Ms(15); // Wait 1.5 Seconds
// Place your code for EW_GREEN here
break;

case EW_YELLOW: Delay100Ms(15); // Wait 1.5 Seconds
// Place your code for EW_YELLOW here
break;

case NS_GREEN: Delay100Ms(15); // Wait 1.5 Seconds
// Place your code for NS_GREEN here
break;

case NS_YELLOW: Delay100Ms(15); // Wait 1.5 Seconds
// Place your code for NS_YELLOW here
break;
}

l Project -> Open -> lab2.mcp
l Edit lab2.c and add the state transition code as follows:
switch(state){

case EW_GREEN: Delay100Ms(15); // Wait 1.5 Seconds
// Place your code for EW_GREEN here
break;

case EW_YELLOW: Delay100Ms(15); // Wait 1.5 Seconds
// Place your code for EW_YELLOW here
break;

case NS_GREEN: Delay100Ms(15); // Wait 1.5 Seconds
// Place your code for NS_GREEN here
break;

case NS_YELLOW: Delay100Ms(15); // Wait 1.5 Seconds
// Place your code for NS_YELLOW here
break;
}
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Lab 3: Using Timer 2 for
Sampling Interval

Lab 3: Using Timer 2 forLab 3: Using Timer 2 for
Sampling IntervalSampling Interval

l Timer 2 and PR2  are used to create an
automatic high priority periodic interrupt

l PICmicro running at 40 Mhz / 100 nS
instruction cycle

l Desire 5 Khz sampling rate = 200 uS
l 200 uS / (100 nS instruction cycle = 2000

instruction cycles
l Assign Timer 2 to the high priority vector and

enable high priority interrupts

l Timer 2 and PR2  are used to create an
automatic high priority periodic interrupt

l PICmicro running at 40 Mhz / 100 nS
instruction cycle

l Desire 5 Khz sampling rate = 200 uS
l 200 uS / (100 nS instruction cycle = 2000

instruction cycles
l Assign Timer 2 to the high priority vector and

enable high priority interrupts
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Using PIC18FXXX Peripheral
Calculations Spreadsheet

Using PIC18FXXX PeripheralUsing PIC18FXXX Peripheral
Calculations SpreadsheetCalculations Spreadsheet
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Timer 2 and A/D Initialization
and Interrupt Assignment

Timer 2 and A/D InitializationTimer 2 and A/D Initialization
and Interrupt Assignmentand Interrupt Assignment

ADCON0 = 0b10000001;// A/D on, Channel 0, CLK/64 clock
ADCON1 = 0b01000010;// Left Justification, CLK/64

// clock, AN0~AN4 analog

T2CON = 0b00001101; // TMR2 On, 4:1 pre, 2:1 post scaller
PR2 = 249; // Select 250 cycle period
PIE1bits.TMR2IE = 1;// Enable Timer 2 interrupts
IPR1 = 0b00000010; // High priority for Timer 2
IPR2 = 0; // Low priority for other peripherals
RCONbits.IPEN = 1; // Enable high / low priority feature
INTCON = 0b11000000;// Enable Low and High priority interrupts

ADCON0 = 0b10000001;// A/D on, Channel 0, CLK/64 clock
ADCON1 = 0b01000010;// Left Justification, CLK/64

// clock, AN0~AN4 analog

T2CON = 0b00001101; // TMR2 On, 4:1 pre, 2:1 post scaller
PR2 = 249; // Select 250 cycle period
PIE1bits.TMR2IE = 1;// Enable Timer 2 interrupts
IPR1 = 0b00000010; // High priority for Timer 2
IPR2 = 0; // Low priority for other peripherals
RCONbits.IPEN = 1; // Enable high / low priority feature
INTCON = 0b11000000;// Enable Low and High priority interrupts
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Lab 3: sample_adc
ISR Flowchart

Lab 3: sample_Lab 3: sample_adcadc
ISR FlowchartISR Flowchart

ADCON0bits.GO_DONE = 1?
Yes

No

Start ADC Conversion
ADCON0bits.GO_DONE = 1 

Clear Timer 2 Interrupt Flag
PIR1bits.TMR2IF = 0

Increment buffer_index

INBUFFER[buffer_index] = ADRESH

buffer_index = 32?

No

Yes

buffer_index = 0

start_dft = 1

Exit sample_adc() ISR

Enter sample_adc() ISR
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Lab 3: Write code for Interrupt
Driven Sampling Routine

Lab 3: Write code for InterruptLab 3: Write code for Interrupt
Driven Sampling RoutineDriven Sampling Routine

#pragma interrupt sample_adc // High priority interrupt
void sample_adc (void){ // TMR2 overflow every 2,000 

// cycles, 200 uS / 5 Khz @ 40 Mhz
if (PIR1bits.TMR2IF){

// Start A/D conversion
// Clear TMR2 interrupt flag
// Spin lock + wait for A/D conversion to complete
// Store A/D result into next location in INBUFFER
// Increment buffer_index and use next buffer location
// Once you hit the end of the INBUFFER[32]:

// - Reset the pointer to zero
// - Set start_dft flag bit to run the DFT

}
}

#pragma interrupt sample_adc // High priority interrupt
void sample_adc (void){ // TMR2 overflow every 2,000 

// cycles, 200 uS / 5 Khz @ 40 Mhz
if (PIR1bits.TMR2IF){

// Start A/D conversion
// Clear TMR2 interrupt flag
// Spin lock + wait for A/D conversion to complete
// Store A/D result into next location in INBUFFER
// Increment buffer_index and use next buffer location
// Once you hit the end of the INBUFFER[32]:

// - Reset the pointer to zero
// - Set start_dft flag bit to run the DFT

}
}
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Lab 3: InstructionsLab 3: InstructionsLab 3: Instructions

l Fill in source code for sample_adc() using:
l INBUFFER[32] stores results
l buffer_index accesses each element
l ADCON0bits.GO_DONE starts ADC conversion
l ADCON0bits.GO_DONE is 1 when ADC is busy
l ADRESH returns 8-bit ADC value
l start_dft = 1 when buffer is full, clear buffer_index

l Build/Compile code, program target
l Set breakpoint where you set start_dft
l Run and examine INBUFFER[] for results ->>>

l Fill in source code for sample_adc() using:
l INBUFFER[32] stores results
l buffer_index accesses each element
l ADCON0bits.GO_DONE starts ADC conversion
l ADCON0bits.GO_DONE is 1 when ADC is busy
l ADRESH returns 8-bit ADC value
l start_dft = 1 when buffer is full, clear buffer_index

l Build/Compile code, program target
l Set breakpoint where you set start_dft
l Run and examine INBUFFER[] for results ->>>
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INBUFFER[32]
Results

INBUFFER[32]INBUFFER[32]
ResultsResults

l View Input Sample Buffer
in Watch Window:
l INBUFFER[32] Shows

A/D sampling Results
l Values should be

centered around 0x80
l All 32 locations should be

captured and stored

l View Input Sample Buffer
in Watch Window:
l INBUFFER[32] Shows

A/D sampling Results
l Values should be

centered around 0x80
l All 32 locations should be

captured and stored
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Graphing INBUFFER[ ] Results
Add the following code…..

Graphing INBUFFER[ ] ResultsGraphing INBUFFER[ ] Results
Add the following code…..Add the following code…..

result_index = 0

result_index = 16? Plot Finished
Yes

No

result_index += 1

lcd_bargraph(INBUFFER[result_index] / 0x10,
result_index)

start_dft = 1?

main()

Build Project, Run and
Speak into the microphone.

You should see a time
domain plot of your voice!
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General DSP ModelGeneral DSP ModelGeneral DSP Model

l Accepts an analog signal
l Converts this analog signal to digital domain
l Performs computations
l Displays results, makes decisions or converts

results back into analog signal

l Accepts an analog signal
l Converts this analog signal to digital domain
l Performs computations
l Displays results, makes decisions or converts

results back into analog signal

Processor

10110101 00100100

Signal Conditioning

Low-pass filter

A to D
Converter

Smoothing Filter

D to A
Converter

Output Amp
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l Convert Time
Domain
Sampled Data
to…

l Frequency
Domain Data

l Convert Time
Domain
Sampled Data
to…

l Frequency
Domain Data

-6

-4

-2

0

2

4

6

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

Converting Time Domain
to Frequency Domain

Converting Time Domain
to Frequency Domain

Discrete Fourier
Transform
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Discrete Fourier TransformDiscrete Fourier TransformDiscrete Fourier Transform

X[F]   = X[F]   =       ΣΣ    X[n]     X[n] ⊗⊗ sin(2 sin(2ππnFnF/N)/N)2 + 2 +  X[n]  X[n] ⊗⊗  coscos(2(2ππnFnF/N)/N)2 2 

n = Nn = N

n = 1n = 1

Discrete Fourier Transform Formula:Discrete Fourier Transform Formula:

N  = Number of SamplesN  = Number of Samples
F    = Frequency Bin NumberF    = Frequency Bin Number
FFhzhz = F * (Sampling Frequency / Number of Samples) = F * (Sampling Frequency / Number of Samples)Example: Example: 

Sampling Frequency = 5 Sampling Frequency = 5 KhzKhz
(32) Samples(32) Samples

ffhzhz = f * (5,000 / 32) = f * 156.25 Hz = f * (5,000 / 32) = f * 156.25 Hz

FF11 = 156.25 Hz = 156.25 Hz
FF22 = 312.5 Hz = 312.5 Hz
FF33 = 468.75 Hz = 468.75 Hz
FF44 = 625 Hz = 625 Hz

FF55 = 781.25Hz = 781.25Hz
FF66 = 937.5 Hz = 937.5 Hz
FF77 = 1093.75 Hz = 1093.75 Hz
FF88 = 1250 Hz = 1250 Hz

FF99 =  1406.25 Hz =  1406.25 Hz
FF1010 = 1562.5 Hz = 1562.5 Hz
FF1111 = 1718.75 Hz = 1718.75 Hz
FF1212 = 1875 Hz = 1875 Hz

FF1313 = 2031.25 Hz = 2031.25 Hz
FF1414 = 2187.5 Hz = 2187.5 Hz
FF1515 = 2343.75 Hz = 2343.75 Hz
FF1616 = 2500 Hz = 2500 Hz
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DFT Frequency Bin
Calculations

DFT Frequency BinDFT Frequency Bin
CalculationsCalculations

IBIN [BINCOUNT]  =  IBIN [BINCOUNT]  =  ΣΣ INBUFFER[N]  INBUFFER[N] ⊗⊗ FTABLE [mod FTABLE [mod3232(N (N ⊗⊗ BINCOUNT)] BINCOUNT)]
BINCOUNT = 1BINCOUNT = 1

BINCOUNT = 16BINCOUNT = 16 N = 32N = 32

N = 1N = 1

Imaginary Magnitude Calculation using Sine tableImaginary Magnitude Calculation using Sine table

(16) frequency bins * (32) samples = (512) 24-bit MAC operations(16) frequency bins * (32) samples = (512) 24-bit MAC operations

QBIN [BINCOUNT] = QBIN [BINCOUNT] = ΣΣ INBUFFER[N]  INBUFFER[N] ⊗⊗ FTABLE [mod FTABLE [mod3232(8 + N (8 + N ⊗⊗ BINCOUNT)] BINCOUNT)]
BINCOUNT = 1BINCOUNT = 1

BINCOUNT = 16BINCOUNT = 16 N = 32N = 32

N = 1N = 1

Real Magnitude Calculation using Cosine tableReal Magnitude Calculation using Cosine table

(16) frequency bins * (32) samples = (512) 24-bit MAC operations(16) frequency bins * (32) samples = (512) 24-bit MAC operations
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DFT Data StructuresDFT Data StructuresDFT Data Structures

l INBUFFER[32] : 8-bit A/D samples buffer
l FTABLE[32] : 8-bit Signed sine wave

l Cosine derived by phase shifting FTABLE[32]
90 degrees or (8) samples.

l IBIN[16] : 24-bit Imaginary result
l QBIN[16] : 24-bit real result
l magnitude[16] : 32-bit scaled I2 + Q2

l INBUFFER[32] : 8-bit A/D samples buffer
l FTABLE[32] : 8-bit Signed sine wave

l Cosine derived by phase shifting FTABLE[32]
90 degrees or (8) samples.

l IBIN[16] : 24-bit Imaginary result
l QBIN[16] : 24-bit real result
l magnitude[16] : 32-bit scaled I2 + Q2
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Frequency Table FTABLE[32]Frequency Table FTABLE[32]Frequency Table FTABLE[32]

••32-sample signed Sine and32-sample signed Sine and
Cosine Wave, F[1]Cosine Wave, F[1]
•• Single table can be used by Single table can be used by
phase shifting sine by 90 degreesphase shifting sine by 90 degrees
or (8) sample pointsor (8) sample points

0

50

100

150

200

250

300

1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 31

-300

-200

-100

0

100

200

300

1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 31

•• Absolute Value of 32-sample Absolute Value of 32-sample
Sine and Cosine Wave, F[1]Sine and Cosine Wave, F[1]

•• Increases Resolution by one bit Increases Resolution by one bit
•• Simplifies signed accumulation Simplifies signed accumulation
math in DFTmath in DFT

FFsamplesample = 5  = 5 Khz Khz / 200 / 200 uSuS
(32) Samples -> F[1] = 5 (32) Samples -> F[1] = 5 KhzKhz / 32 / 32
F[1] 156.25 Hz, BINCOUNT = 1F[1] 156.25 Hz, BINCOUNT = 1
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F[N] Bin GenerationF[N] Bin GenerationF[N] Bin Generation

-300

-200

-100

0

100

200

300

1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 31

-300

-200

-100

0

100

200

300

1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 31

-300

-200

-100

0

100

200

300

1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 31

-300

-200

-100

0

100

200

300

1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 31

F[2] 312.5 Hz, BINCOUNT = 2F[2] 312.5 Hz, BINCOUNT = 2

F[3] 468.75 Hz, BINCOUNT = 3F[3] 468.75 Hz, BINCOUNT = 3

F[4] 625 Hz, BINCOUNT = 4F[4] 625 Hz, BINCOUNT = 4

F[5] 781.25 Hz, BINCOUNT = 5F[5] 781.25 Hz, BINCOUNT = 5
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Lab 4: DFT ImplementationLab 4: DFT ImplementationLab 4: DFT Implementation
l Once 32 samples have been completed:

l start_dft is set by ISR, indicating
INBUFFER[32] is completed

l Call dft();
l dft() takes INBUFFER[32], convolves this

with FTABLE[32] calculating IBIN[16] and
QBIN[16]

l magnitude[F] = (unsigned long)(IBIN[F]>>8)2 +
(unsigned long)(QBIN[F]>>8)2

l Scale magnitude result for 0~16 bar display
l Use lcd_bargraph(magnitude,location) to plot

all 16 frequency magnitude bins

l Once 32 samples have been completed:
l start_dft is set by ISR, indicating

INBUFFER[32] is completed
l Call dft();

l dft() takes INBUFFER[32], convolves this
with FTABLE[32] calculating IBIN[16] and
QBIN[16]

l magnitude[F] = (unsigned long)(IBIN[F]>>8)2 +
(unsigned long)(QBIN[F]>>8)2

l Scale magnitude result for 0~16 bar display
l Use lcd_bargraph(magnitude,location) to plot

all 16 frequency magnitude bins
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DFT Invocation FlowchartDFT Invocation FlowchartDFT Invocation Flowchart

start_dft = 1?

dft()
result_index = 0
max_result = 0

magnitude
[result_index] >

max_result?

magnitude[result_index] = 
(unsigned long)(IBIN[result_index]>>8)2 +

(unsigned long)(QBIN[result_index]>>8)2

result_index += 1

result_index = 16?
max_result =
magnitude

[result_index]

main()

scale results
(see next slide)

Yes

No

Yes

No
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DFT Scaling + Plotting
Flowchart

DFT Scaling + PlottingDFT Scaling + Plotting
FlowchartFlowchart

max_result > 16 ?

result_index = 0
result_index  =

16?

result_index = 0;
magnitude_divisor = max_result/16

result_index += 1

result_index = 16?
magnitude

[result_index] /=
magnitude_divisor

scale results

DFT Finished
Yes

No

Yes

No

result_index += 1

lcd_bargraph(magnitude[result_index],
result_index)

Yes

No
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DFT TestingDFT TestingDFT Testing

l Build project, program target and run code
l LCD shows a real-time spectrum analyzer

bargraph:

l Build project, program target and run code
l LCD shows a real-time spectrum analyzer

bargraph:

0

2

4

6

8

10

12

14

16

18

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Audio Test Frequency
Generator

Audio Test FrequencyAudio Test Frequency
GeneratorGenerator

l WinISD Audio Frequency Generator and
Speaker Design Tool created by Juha
Hartikainen www.linearteam.org

l WinISD Audio Frequency Generator and
Speaker Design Tool created by Juha
Hartikainen www.linearteam.org

•• Sweeping Audio Tones Sweeping Audio Tones

•• Fixed Audio Tones Fixed Audio Tones

•• Attenuation control Attenuation control

•• Audio Speaker Design Tool Audio Speaker Design Tool



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 184

Internal DFT resultsInternal DFT resultsInternal DFT results

l Set breakpoint after lcd_bargraph invocation and
View->Watch to look at the following values in
watch window:
l IBIN[16] - Real magnitude
l QBIN[16] - Imaginary magnitude
l magnitude[16] - Total magnitude
l max_result - Maximum magnitude value
l INBUFFER[32] - Input buffer samples
l FTABLE[32] - Sine / Cosine waveforms used in DFT

convolution.

l Select Decimal display format by right clicking on
each variable -> Properties, Format = Decimal

l Set breakpoint after lcd_bargraph invocation and
View->Watch to look at the following values in
watch window:
l IBIN[16] - Real magnitude
l QBIN[16] - Imaginary magnitude
l magnitude[16] - Total magnitude
l max_result - Maximum magnitude value
l INBUFFER[32] - Input buffer samples
l FTABLE[32] - Sine / Cosine waveforms used in DFT

convolution.

l Select Decimal display format by right clicking on
each variable -> Properties, Format = Decimal
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Lab 5: Automatic Gain ControlLab 5: Automatic Gain ControlLab 5: Automatic Gain Control
l Digital POT selects microphone gain
l Gain stored in pot_value.  Default = 0xF2
l Use WritePOT(pot_value) to change

microphone gain
l Scan INBUFFER[32] for clipped values

l Centered around 128
l Clip when < 64 or > 192

l Increase pot_value gain by one until clipping
l Decrease pot_value gain by the number of

clipping events

l Digital POT selects microphone gain
l Gain stored in pot_value.  Default = 0xF2
l Use WritePOT(pot_value) to change

microphone gain
l Scan INBUFFER[32] for clipped values

l Centered around 128
l Clip when < 64 or > 192

l Increase pot_value gain by one until clipping
l Decrease pot_value gain by the number of

clipping events



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 186

Automatic Gain Control
Flowchart

Automatic Gain ControlAutomatic Gain Control
FlowchartFlowchart

result_index = 32 ?

pot_value += 1

INBUFFER[result_index]
> 192     or

INBUFFER[result_index]
< 64

result_index += 1

agc_value = 0
&& pot_value < 255?

agc_value += 1

DFT Finished

AGC Finished

Yes

Yes

No
WritePOT(pot_value)

pot_value -=1
agc_value -=1

Yes

No

result_index = 0
agc_value = 0

No

agc_value > 0
and pot_value > 0?

No
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Congratulations, PIC18FXXX
Expert…….

Congratulations, PIC18FXXXCongratulations, PIC18FXXX
Expert…….Expert…….

l You now have the experience needed to
design and complete an embedded systems
application using the PIC18FXXX

l We hope you enjoyed this session!
l Please fill out the feedback forms
l Thanks for joining us!

l You now have the experience needed to
design and complete an embedded systems
application using the PIC18FXXX

l We hope you enjoyed this session!
l Please fill out the feedback forms
l Thanks for joining us!
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Appendix A:

Improving Code Size With the
MPLAB C18 Compiler

Appendix A:Appendix A:

Improving Code Size With theImproving Code Size With the
MPLAB C18 CompilerMPLAB C18 Compiler
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Our Goal: To understand how to reduce C
application code size on PIC18 MCUs
through intelligent use of MPLAB C18 and
careful structuring of C code.

Our Goal: To understand how to reduce C
application code size on PIC18 MCUs
through intelligent use of MPLAB C18 and
careful structuring of C code.
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Suggestion #1Suggestion #1Suggestion #1

Use the latest version of MPLAB C18Use the latest version of MPLAB C18
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Code Size Comparison
Default Options

Code Size ComparisonCode Size Comparison
Default OptionsDefault Options
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(CQ3’02)
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Suggestion #2Suggestion #2Suggestion #2

Carefully select command-line optionsCarefully select command-line options
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Code Size Comparison
Choosing Command-Line Options
Code Size ComparisonCode Size Comparison
Choosing Command-Line OptionsChoosing Command-Line Options
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Command-Line Options
LFSR Use

Command-Line OptionsCommand-Line Options
LFSR UseLFSR Use

l MPLAB-C18’s -lfsr switch enables use of
the LFSR instruction

l Currently, MPLAB-C18 assumes that LFSR
shouldn’t be used without the -lfsr switch
given

l The switch should always be used when it is
known that the LFSR errata doesn’t exist on
the targeted part

l MPLAB-C18’s -lfsr switch enables use of
the LFSR instruction

l Currently, MPLAB-C18 assumes that LFSR
shouldn’t be used without the -lfsr switch
given

l The switch should always be used when it is
known that the LFSR errata doesn’t exist on
the targeted part
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Command-Line Options
Optimizations

Command-Line OptionsCommand-Line Options
OptimizationsOptimizations

l All of MPLAB-C18’s optimizations currently
target code size

l Optimizations should be enabled for smallest
code size

l NOTE: Optimizations may interfere with
MPLAB debugging

l All of MPLAB-C18’s optimizations currently
target code size

l Optimizations should be enabled for smallest
code size

l NOTE: Optimizations may interfere with
MPLAB debugging
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Command-Line Options
Memory Model

Command-Line OptionsCommand-Line Options
Memory ModelMemory Model

l MPLAB-C18 has two memory models:

-ms: small memory model (pointers to program
memory are 16-bits wide)

-ml: large memory model (pointers to program
memory are 24-bits wide)

l Use -ms whenever possible

l MPLAB-C18 has two memory models:

-ms: small memory model (pointers to program
memory are 16-bits wide)

-ml: large memory model (pointers to program
memory are 24-bits wide)

l Use -ms whenever possible
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Suggestion #3Suggestion #3Suggestion #3

Select appropriate storage class for dataSelect appropriate storage class for data
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Command-Line Options
Data Storage Class

Command-Line OptionsCommand-Line Options
Data Storage ClassData Storage Class

l Default storage class for parameters and
local variables is auto

â Parameters are passed on the software stack

â Locals are located on the software stack

l Default storage class for parameters and
local variables is auto

â Parameters are passed on the software stack

â Locals are located on the software stack
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Using auto VariablesUsing Using autoauto Variables Variables

Example - calculate the expression (a + b):

6 program words
(not counting prolog/epilog)

Example - calculate the expression (a + b):

6 program words
(not counting prolog/epilog)

movlw offset(a)
movff PLUSW2, tmp
movlw offset(b)
movf PLUSW2
addwf tmp
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Command-Line Options
Data Storage Class

Command-Line OptionsCommand-Line Options
Data Storage ClassData Storage Class

l C also provides for static local variables
l MPLAB-C18 extends C with static parameters

(available in v1.10 and later)
l For example:

char add( static char a, static char b )
{

static char result;
result = a + b;
return result;

}

l C also provides for static local variables
l MPLAB-C18 extends C with static parameters

(available in v1.10 and later)
l For example:

char add( static char a, static char b )
{

static char result;
result = a + b;
return result;

}
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Using static VariablesUsing Using staticstatic Variables Variables

Example - calculate the expression (a + b):

3 program words
(no prolog/epilog required)

Example - calculate the expression (a + b):

3 program words
(no prolog/epilog required)

movlb b*
movf b
addwf a

*likely target for optimization
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static Gotchasstaticstatic  GotchasGotchas

l Gotcha #1 - Reentrant code
Variables may overwrite themselves

l Recursion (function calls itself)

l Function called (directly or indirectly) from
main() and an ISR.

l Gotcha #1 - Reentrant code
Variables may overwrite themselves

l Recursion (function calls itself)

l Function called (directly or indirectly) from
main() and an ISR.
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static Gotchasstaticstatic  GotchasGotchas

l Gotcha #2 - Function pointers
Address of parameters not known at compile time

l Function pointers may not be used with
functions containing static parameters

l Gotcha #2 - Function pointers
Address of parameters not known at compile time

l Function pointers may not be used with
functions containing static parameters



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 204

static Gotchasstaticstatic  GotchasGotchas

l Gotcha #3 - Matching declarations
All declarations must use explicit storage class if not all files
are compiled with the same default

l Example:
char add( char a, char b );

Will only work if the default storage class is
identical in both the declaring and defining
files.

l Gotcha #3 - Matching declarations
All declarations must use explicit storage class if not all files
are compiled with the same default

l Example:
char add( char a, char b );

Will only work if the default storage class is
identical in both the declaring and defining
files.
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l What if one of the “static Gotchas” applies to
your code?

ã Best case: use -ol on all files and explicit auto
storage class as needed.

ã Intermediate case: Use -ol on as many files as
possible and explicit storage classes as needed.

ã Worst case: Don’t use -ol, but use explicit
static storage class as much as possible.

l What if one of the “static Gotchas” applies to
your code?

ã Best case: use -ol on all files and explicit auto
storage class as needed.

ã Intermediate case: Use -ol on as many files as
possible and explicit storage classes as needed.

ã Worst case: Don’t use -ol, but use explicit
static storage class as much as possible.

static Gotchasstaticstatic Gotchas Gotchas
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Command-Line Options
Data Storage Class

Command-Line OptionsCommand-Line Options
Data Storage ClassData Storage Class

l MPLAB-C18 v2.0 and later extends C with
the overlay storage class for local
variables

l Behaves identically to the static storage
class, except:

l RAM locations are overlaid by the linker when
possible based on a call tree analysis

l Default storage class can be set to overlay
using the -sco option

l MPLAB-C18 v2.0 and later extends C with
the overlay storage class for local
variables

l Behaves identically to the static storage
class, except:

l RAM locations are overlaid by the linker when
possible based on a call tree analysis

l Default storage class can be set to overlay
using the -sco option
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Suggestion #4Suggestion #4Suggestion #4

Choose smallest data type possibleChoose smallest data type possible
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MPLAB-C18 Data TypesMPLAB-C18 Data TypesMPLAB-C18 Data Types

Type Min Value Max Value
unsigned char 0 255
signed char -128 127
unsigned int 0 65,535
signed int -32,768 32,767
unsigned short long 0 16,777,215
signed short long -8,388,608 8,388,607
unsigned long 0 4,294,967,295
signed long -2,147,483,648 2,147,483,647

Type Min Value Max Value
unsigned char 0 255
signed char -128 127
unsigned int 0 65,535
signed int -32,768 32,767
unsigned short long 0 16,777,215
signed short long -8,388,608 8,388,607
unsigned long 0 4,294,967,295
signed long -2,147,483,648 2,147,483,647
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Using Appropriate Data TypesUsing Appropriate Data TypesUsing Appropriate Data Types

c = a + bc = a + b

char:

  MOVLB     b
  MOVF      b,0,1
  ADDWF     a,0,1
  MOVWF     c,1

(4 words)

int:

  MOVLB   a
  MOVF    b,0,1
  ADDWF   a,0,1
  MOVWF   c,1
  MOVF    high(b),0,1
  ADDWFC  high(a),0,1
  MOVWF   high(c),1

(7 words)
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Suggestion #5Suggestion #5Suggestion #5

Use access RAM for your variablesUse access RAM for your variables
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Variable Allocation
Using Access RAM

Variable AllocationVariable Allocation
Using Access RAMUsing Access RAM

l MPLAB-C18 allows for efficient use of
unbanked RAM with the near type specifier

l RAM variables will default to near by using
the -oa option

l Compiler won’t emit movlb instructions for
accessing these variables

l MPLAB-C18 allows for efficient use of
unbanked RAM with the near type specifier

l RAM variables will default to near by using
the -oa option

l Compiler won’t emit movlb instructions for
accessing these variables
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Variable Allocation
Using Access RAM

Variable AllocationVariable Allocation
Using Access RAMUsing Access RAM

l Use the near specifier for the most
frequently accessed variables

l Gotcha: as with static and overlay,
prototypes must match definitions

l Use the near specifier for the most
frequently accessed variables

l Gotcha: as with static and overlay,
prototypes must match definitions
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Suggestion #6Suggestion #6Suggestion #6

Keep definitions in same file with referencesKeep definitions in same file with references
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Variable Allocation
Defining Variables

Variable AllocationVariable Allocation
Defining VariablesDefining Variables

l MPLAB-C18 can be more aggressive
optimizing variables in the files where they
are defined.

l MPLAB-C18 can be more aggressive
optimizing variables in the files where they
are defined.

  char a, b, c;

  void foo( void )

  {

     c = a + b;

  }

Source code:

  MOVLB     b
  MOVF      b,0,1
  ADDWF     a,0,1
  MOVWF     c,1

(4 words)

Machine code:
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Variable Allocation
Defining Variables

Variable AllocationVariable Allocation
Defining VariablesDefining Variables

l MPLAB-C18 must be more conservative with
externally-defined variables

l MPLAB-C18 must be more conservative with
externally-defined variables

 extern char a, b, c;

 void foo( void )

 {

    c = a + b;

 }

Source code:

  MOVLB     b
  MOVF      b,0,1
  MOVLB     a
  ADDWF     a,0,1
  MOVLB     c
  MOVWF     c,1

(6 words)

Machine code:
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Suggestion #7Suggestion #7Suggestion #7

Use #pragma varlocateUse #pragma varlocate
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Using #pragma varlocateUsing Using ##pragma varlocatepragma varlocate

l Use #pragma varlocate to tell the compiler
what bank a variable is located in

l Use #pragma varlocate to tell the compiler
what bank a variable is located in

 extern char a, b, c;

 void foo( void )

 {

    c = a + b;

 }

Source code:

  MOVLB     b
  MOVF      b,0,1
  MOVLB     a
  ADDWF     a,0,1
  MOVLB     c
  MOVWF     c,1

(6 words)

Machine code:
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Using #pragma varlocateUsing Using ##pragma varlocatepragma varlocate

l Improves MPLAB-C18 banking optimizerl Improves MPLAB-C18 banking optimizer

 #pragma varlocate 3 a, b, c

 extern char a, b, c;

 void foo( void )

 {

    c = a + b;

 }

Source code:

  MOVLB     b
  MOVF      b,0,1
  ADDWF     a,0,1
  MOVWF     c,1

(4 words)

Machine code:
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Using #pragma varlocateUsing Using ##pragma varlocatepragma varlocate

Gotcha: has no impact on how variables are
actually allocated

Gotcha: has no impact on how variables are
actually allocated
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Suggestion #8Suggestion #8Suggestion #8

Replace Common Expressions With VariablesReplace Common Expressions With Variables
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Common Sub-Expression
Elimination

Common Sub-ExpressionCommon Sub-Expression
EliminationElimination

l Applies to all types of expressionsl Applies to all types of expressions

  MY_STRUCT s[10];

  for(i=0; i<10; i++)

  {

s[i].a = i;

s[i].b = 34;

  }

Code size:

  10 words to calculate s[i]
  2 words to assign i
  10 words to calculate s[i]
  3 words to assign 34

= 25 words total

Source code:
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Common Sub-Expression
Elimination (Contd.)

Common Sub-ExpressionCommon Sub-Expression
Elimination (Elimination (ContdContd.).)

  MY_STRUCT s[10];
  MY_STRUCT *p = &(s[0]);

  for(i=0; i<10; i++)
  {
    p->a = i;
    p->b = 34;
    p++;
  }

Code size:Source code:

  0 words to calculate s[i]
  6 words to assign i
  7 words to assign 34
  4 words to increment p

= 17 words total
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Suggestion #9Suggestion #9Suggestion #9

Don’t Use a Variable When a Constant Will DoDon’t Use a Variable When a Constant Will Do
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Constant EvaluationsConstant EvaluationsConstant Evaluations

l Pre-calculate all values that can be
determined at compile-time.

l Pre-calculate all values that can be
determined at compile-time.

  a = 2;

  b = 17 + 52 * a;

  c = b;

  c = 121;

Original source: Transformed source:
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Appendix B:

PIC18FXXXX
Instruction

Set and PIC16/17
Migration

Appendix B:Appendix B:

PIC18FXXXXPIC18FXXXX
InstructionInstruction

Set and PIC16/17Set and PIC16/17
MigrationMigration



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 226

PIC18 Architecture
ALU : Status Register

PIC18 ArchitecturePIC18 Architecture
ALU : Status RegisterALU : Status Register

bit 7 bit 0

- - - N OV Z DC C

STATUS Register FormatSTATUS Register Format

Bit definitionsBit definitions

N Negative/Positive ALU result is negative
OV OVerflow 2’s Complement Overflow

occurred
Z Zero Result is zero
DC Digit Carry / !Borrow Carry/borrow from lower nibble
C Carry / !Borrow Carry/borrow from upper nibble
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PIC18 Architecture
Data Memory

PIC18 ArchitecturePIC18 Architecture
Data MemoryData Memory

l Up to 16 banks of
256 bytes of SRAM
l Unused banks read

‘00h’

l Bank selected by
BSR<3:0>

l Linear access
l SFR are located in

Bank 14 and/or 15

l Up to 16 banks of
256 bytes of SRAM
l Unused banks read

‘00h’

l Bank selected by
BSR<3:0>

l Linear access
l SFR are located in

Bank 14 and/or 15

Memory Map
000h

0FFh
100h

1FFh
200h

FFFh

GPR (Bank 0)

GPR (Bank 1)

...

GPR (Bank 14)

GPRs Or SFRs

SFRs

D00h

DFFh
E00h

EFFh
F00h
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PIC18 Architecture
Accessing Data Memory
PIC18 ArchitecturePIC18 Architecture
Accessing Data MemoryAccessing Data Memory

l Select a bank
l BSR<3:0> contains bank

l Instruction with 8-bit
address as operand
l “BANKED” bit

l MPASM assembler tip
l 12-bit Register address
l Use BANKSEL directive
l Let MPASM assembler set

“BANKED” bit

l Select a bank
l BSR<3:0> contains bank

l Instruction with 8-bit
address as operand
l “BANKED” bit

l MPASM assembler tip
l 12-bit Register address
l Use BANKSEL directive
l Let MPASM assembler set

“BANKED” bit

GPR (Bank n-1)

GPR (Bank n)

GPR (Bank n+1)

BSR<3:0>BSR<3:0>

8-bit 8-bit AddrAddr..

Points toPoints to
BankBank

Points to OffsetPoints to Offset
Within BankWithin Bank
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PIC18 Architecture
Accessing Data Memory
PIC18 ArchitecturePIC18 Architecture
Accessing Data MemoryAccessing Data Memory

Effective 12-bit Register AddressEffective 12-bit Register Address

OP CODE

BSR RegisterBSR Register 16-bit Instruction16-bit Instruction

BSR<3:0> f f f f f f f

8-bits from Instruction Word8-bits from Instruction Word

f

BSR<3:0>

4-bits from4-bits from
BSR BSR 
RegisterRegister

a f f f f f f f f

l Instruction Format Example:l Instruction Format Example:

“BANKED” bit
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l 256 bytes of non-
banked memory

l Fast access to
frequently used
registers (SFRs and
GPRs)

l Size of Access Bank
depends on device
l e.g. PIC18FXX2:

128/128;
PIC18FXX8: 96/160

l 256 bytes of non-
banked memory

l Fast access to
frequently used
registers (SFRs and
GPRs)

l Size of Access Bank
depends on device
l e.g. PIC18FXX2:

128/128;
PIC18FXX8: 96/160

PIC18 Architecture
Access Bank

PIC18 ArchitecturePIC18 Architecture
Access BankAccess Bank

* Note: Check your device datasheet* Note: Check your device datasheet

Memory Map

Access Bank *

000h

0FFh

Access RAM

00h

7Fh
80h

FFh

Bank 0

Bank 1

...

Bank 14

Access RAM

Bank 15

Access Bank Lo

Access Bank Hi

100h

1FFh

F00h

FFFh

E00h

EFFh
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PIC18 Architecture
Accessing Access Bank
PIC18 ArchitecturePIC18 Architecture
Accessing Access BankAccessing Access Bank

l Instruction with 8-bit
address as operand
l Special “ACCESS” bit

l MPASM assembler tip
l 12-bit Register address
l Let MPASM assembler

set “ACCESS” bit

l Instruction with 8-bit
address as operand
l Special “ACCESS” bit

l MPASM assembler tip
l 12-bit Register address
l Let MPASM assembler

set “ACCESS” bit

Access Bank
Low

Access Bank
High

8-bit Add.8-bit Add.

00h

FFh
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PIC18 Architecture
Accessing Access Bank
PIC18 ArchitecturePIC18 Architecture
Accessing Access BankAccessing Access Bank

l Instruction Format Example:l Instruction Format Example:

8-bit Access Register Address8-bit Access Register Address

OP CODE

16-bit Instruction16-bit Instruction

f f f f f f f

8-bits from Instruction Word8-bits from Instruction Word

f

a f f f f f f f f

“ACCESS” bit
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PIC18 Architecture
Program Memory Storage Scheme

PIC18 ArchitecturePIC18 Architecture
Program Memory Storage SchemeProgram Memory Storage Scheme

l Little-Endian Formatl Little-Endian Format
Instruction Opcode Memory Address
… 00007h

55h 00008hMOVLW 55h 0E55h
0Eh 00009h

GOTO 06h EF03h, F000h 03h 0000Ah

EFh 0000Bh
00h 0000Ch
F0h 0000Dh



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 234

PIC18 Instructions
Instruction Features

PIC18 InstructionsPIC18 Instructions
Instruction FeaturesInstruction Features

l Upward compatible with PIC16, PIC17,

16-bit Instruction width

l Instruction fetches are 16-bit wide

l Fetch and Execution is overlapped

l Single Cycle 8 x 8 Multiply

l Generates compact code

l Most Instructions are Orthogonal

l Upward compatible with PIC16, PIC17,

16-bit Instruction width

l Instruction fetches are 16-bit wide

l Fetch and Execution is overlapped

l Single Cycle 8 x 8 Multiply

l Generates compact code

l Most Instructions are Orthogonal
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PIC18 Instructions
Instruction Features (Continued)

PIC18 InstructionsPIC18 Instructions
Instruction Features (Continued)Instruction Features (Continued)

l Most Instructions are Single Word

l 71 Single Word; 4 Double Word

l Most Instructions are Single Cycle
l 17 are Double Cycle
l 18 conditional branch/skips are 1, 2 (or 3)

l Register to Register transfer instruction
l Powerful bit manipulation

l Available for entire data memory region

l Most Instructions are Single Word

l 71 Single Word; 4 Double Word

l Most Instructions are Single Cycle
l 17 are Double Cycle
l 18 conditional branch/skips are 1, 2 (or 3)

l Register to Register transfer instruction
l Powerful bit manipulation

l Available for entire data memory region
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16-bit Instruction for Byte Oriented Operations16-bit Instruction for Byte Oriented Operations

OP CODEOP CODE dd

d = Destination Bit
‘W' for WREG (0)
‘F’ for f (1 - Default)

f = 8-bit Register Address

Example:Example:
ADDWFADDWF f [,d [,a]]f [,d [,a]] MOVFF MOVFF fsfs, , fdfd
ADDWF ADDWF CountCount MOVFF Source, MOVFF Source, DestDest

ADDWF f [,d [,a]]
ADDWFC f [,d [,a]]
ANDWF f [,d [,a]]
CLRF f [,a]
COMF f [,d [,a]]
CPFSEQ f [,a] 
CPFSGT f [,a]
CPFSLT f [,a]
DECF f [,d [,a]]
DECFSZ f [,d [,a]]
DCFSNZ f [,d [,a]]
INCF f [,d [,a]]
INCFSZ f [,d [,a]]
INFSNZ f [,d [,a]]
IORWF f [,d [,a]]
MOVF f [,d [,a]]
MOVFF fs, fd 
MOVWF f [,a]

Byte-Oriented
Operations

aa ff ff ff ff ff ff ff ff

a = Access Bit
‘ACCESS’ (0)
‘BANKED’ (1 - Default)

PIC18 Instruction
Byte-Oriented Operations

PIC18 InstructionPIC18 Instruction
Byte-Oriented OperationsByte-Oriented Operations
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16-bit Instruction for Byte Oriented Operations16-bit Instruction for Byte Oriented Operations

OP CODEOP CODE dd

d = Destination Bit
‘W’ for WREG (0)
‘F’ for f (1 - Default)

f = 8-bit Register Address

Example:Example:
SUBWFSUBWF f [,d [,a]]f [,d [,a]]
SUBWF SUBWF Value, WValue, W

Byte-Oriented
Operations

aa ff ff ff ff ff ff ff ff

a = Access Bit
‘ACCESS’ (0)
‘BANKED’ (1 - Default)

MULWFMULWF f [,a]f [,a]
NEGFNEGF f [,a]f [,a]
RLCFRLCF f [,d [,a]]f [,d [,a]]
RLNCFRLNCF f [,d [,a]]f [,d [,a]]
RRCFRRCF f [,d [,a]]f [,d [,a]]
RRNCFRRNCF f [,d [,a]]f [,d [,a]]
SETFSETF f [,a]f [,a]
SUBFWBSUBFWB f [,d [,a]]f [,d [,a]]
SUBWFSUBWF f [,d [,a]]f [,d [,a]]
SUBWFBSUBWFB f [,d [,a]]f [,d [,a]]
SWAPFSWAPF f [,d [,a]]f [,d [,a]]
TSTFSZTSTFSZ f [,a]f [,a]
XORWFXORWF f [,d [,a]]f [,d [,a]]

PIC18 Instructions
Byte-Oriented Operations (Continued)

PIC18 InstructionsPIC18 Instructions
Byte-Oriented Operations (Continued)Byte-Oriented Operations (Continued)
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PIC18 Instructions
Byte-Oriented Operations - Example

PIC18 InstructionsPIC18 Instructions
Byte-Oriented Operations - ExampleByte-Oriented Operations - Example

l Perform Multi-byte (4 byte) increment:
“Count32++”

l Perform Multi-byte (4 byte) increment:
“Count32++”
......

movlwmovlw 01h01h

addwfaddwf Count32, FCount32, F ; Inc LSB by ‘1’; Inc LSB by ‘1’

clrfclrf WREGWREG ; Pass the carry; Pass the carry

addwfc addwfc Count32+1, FCount32+1, F ; to LOW MSB; to LOW MSB

addwfcaddwfc  Count32+2, FCount32+2, F ; to HIGH LSB; to HIGH LSB

addwfc addwfc Count32+3, FCount32+3, F ; to HIGH MSB; to HIGH MSB

......
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16-bit Instruction for Bit Oriented Operations16-bit Instruction for Bit Oriented Operations

OP CODEOP CODE bb

b = 3-Bit Address
(Bit Number)

f = 8-bit Register Address

bb bb

Example:Example:
BTFSCBTFSC f, b [,a]f, b [,a]
BTFSCBTFSC STATUS, CSTATUS, C

BCFBCF f, b [,a]f, b [,a]
BSFBSF f, b [,a]f, b [,a]
BTGBTG f, b [,a]f, b [,a]
BTFSCBTFSC f, b [,a]f, b [,a]
BTFSSBTFSS f, b [,a]f, b [,a]

Bit-Oriented
Operations

a = Access Bit
‘ACCESS’ (0)
‘BANKED’ (1 - Default)

aa ff ff ff ff ff ff ff ff

PIC18 Instructions
Bit-Oriented Operations
PIC18 InstructionsPIC18 Instructions
Bit-Oriented OperationsBit-Oriented Operations
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BCBC nn
BNBN nn
BNCBNC nn
BNNBNN nn
BNOVBNOV nn
BNZBNZ nn
BOVBOV nn
BRABRA nn
BZBZ nn
CALLCALL n [,s]n [,s]
GOTOGOTO nn
RCALLRCALL nn
RETFIERETFIE [s][s]
RETURNRETURN [s][s]

Control
Operations

16-bit Instruction for 16-bit Instruction for RCALLRCALL and  and BRABRA

OP CODEOP CODE

k = 11-bit Immediate Value

nn nn nn nn nn nn nn nn nn nn nn

OP CODEOP CODE ss nn
16-bit Instruction for 16-bit Instruction for CALLCALL and  and GOTOGOTO

nn nn nn nn nn nn nn

k = 20-bit Immediate Value

OP CODEOP CODE nn nn nn nn nn nn nn nn nn nn nn nn

s = 1-bit fast Save/Restore
‘FAST’ (1), (Default - 0)

PIC18 Instructions
Control Operations

PIC18 InstructionsPIC18 Instructions
Control OperationsControl Operations
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PIC18 Instructions
Control Operations (Continued)

PIC18 InstructionsPIC18 Instructions
Control Operations (Continued)Control Operations (Continued)

l (Un)Conditional branches
spans  -128 through +127
Instructions

l CALL and GOTO contain full
21-bit address
l Provides Linear access to

2MB

l RCALL spans -1024 through
1023 Instructions

l (Un)Conditional branches
spans  -128 through +127
Instructions

l CALL and GOTO contain full
21-bit address
l Provides Linear access to

2MB

l RCALL spans -1024 through
1023 Instructions

BCBC nn
BNBN nn
BNCBNC nn
BNNBNN nn
BNOVBNOV nn
BNZBNZ nn
BOVBOV nn
BRABRA nn
BZBZ nn
CALLCALL n [,s]n [,s]
GOTOGOTO nn
RCALLRCALL nn
RETFIERETFIE [s][s]
RETURNRETURN [s][s]

Control
Operations
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CLRWDTCLRWDT
DAWDAW
NOPNOP   
POPPOP
PUSHPUSH
RESETRESET
SLEEPSLEEP

Control
Operations

16-bit Instruction for 16-bit Instruction for CLRWDTCLRWDT    

OP CODEOP CODE

16-bit Instruction for 16-bit Instruction for DAWDAW  

OP CODEOP CODE

PIC18 Instructions
Control Operations (Continued)

PIC18 InstructionsPIC18 Instructions
Control Operations (Continued)Control Operations (Continued)

PUSH and POP operate on Hardware Stack
only
DAW operates on WREG only
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PIC18 Instructions
Control Operations - Example #1

PIC18 InstructionsPIC18 Instructions
Control Operations - Example #1Control Operations - Example #1

Utilize “Save Context”

org org 00008h00008h

brabra HighISRHighISR

......

HighISRHighISR::

......

retfie retfie FASTFAST

... ... 

Handling InterruptHandling Interrupt
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PIC18 Instructions
 Control Operations - Example #2

PIC18 InstructionsPIC18 Instructions
  Control Operations - Example #2Control Operations - Example #2

Wait for an input trigger on PORTB RB6 pin

......

btfscbtfsc PORTB, RB6PORTB, RB6 ; Is RB6 low ?; Is RB6 low ?

brabra $-2$-2 ; No.  Wait…; No.  Wait…

...... ; Yes.; Yes.
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Example:Example:
MOVLWMOVLW kk LFSRLFSR f, kf, k
MOVLWMOVLW 5Ah5Ah LFSR LFSR FSR0, 400hFSR0, 400h

ADDLWADDLW kk
ANDLWANDLW kk
IORLWIORLW kk
LFSRLFSR f, kf, k
MOVLBMOVLB kk
MOVLWMOVLW kk
MULLWMULLW kk
RETLWRETLW kk
SUBLWSUBLW kk
XORLWXORLW kk

Literal
Operations

OP CODEOP CODE ff ff kk

16-bit Instruction for LFSR16-bit Instruction for LFSR

kk kk kk kk kk kk kk

k = 8-bit Immediate Value

f = 2-bit FSR Selector
FSR0, FSR1 or FSR2

OP CODEOP CODE kk

16-bit Instruction for Other Literal Operations16-bit Instruction for Other Literal Operations

kk kk kk kk kk kk kk

k = 8-bit Immediate Value

PIC18 Instructions
Literal Operations

PIC18 InstructionsPIC18 Instructions
Literal OperationsLiteral Operations
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PIC18 Instructions
Literal Operations - Example

PIC18 InstructionsPIC18 Instructions
Literal Operations - ExampleLiteral Operations - Example

......

movlwmovlw 55h55h

movwfmovwf PORTBPORTB

......

Immediate OperationImmediate Operation

......

lfsrlfsr FSR0, 400hFSR0, 400h

movwfmovwf INDF0 INDF0 ; *FSR0; *FSR0

movwfmovwf POSTINC0 POSTINC0 ; *FSR0++; *FSR0++

movwfmovwf POSTDEC0 POSTDEC0 ; *FSR0--; *FSR0--

movwfmovwf PREINC0 PREINC0 ; ; *++*++FSR0FSR0

movwfmovwf PLUSW0 PLUSW0 ; FSR0[WREG]; FSR0[WREG]

Indirect OperationIndirect Operation
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16-bit Instruction for TBLRD*/TBLWT*16-bit Instruction for TBLRD*/TBLWT*

OP CODEOP CODE

TBLRD*TBLRD*
TBLRDTBLRD*+ *+ 
TBLRD*-TBLRD*-
TBLRDTBLRD+*+*
TBLWT* TBLWT* 
TBLWTTBLWT*+*+
TBLWT*- TBLWT*- 
TBLWTTBLWT+*+*

Control
Operations

PIC18 Instructions
Data Ö Program Operations

PIC18 InstructionsPIC18 Instructions
Data Data ÖÖ Program Operations Program Operations

Example:Example:
TBLRD*TBLRD*
TBLRDTBLRD*+*+

TBLRD and TBLWT operate on TABLAT
only
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PIC18 Instructions
Data Ö Program Operations - Example

PIC18 InstructionsPIC18 Instructions
Data Data ÖÖ Program Operations - Example Program Operations - Example

Read a lookup table entry:

movlwmovlw upper(upper(LookUpTableLookUpTable)) ; ; Load look-upLoad look-up

movwfmovwf TBLPTRUTBLPTRU ; ; tabletable

movlwmovlw high(high(LookupTableLookupTable)) ; ; addressaddress

movwfmovwf TBLPTRHTBLPTRH

movlwmovlw low(low(LookupTableLookupTable))

movwfmovwf TBLPTRLTBLPTRL

tblrd*+tblrd*+ ; ; Read it.Read it.
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PIC16C/FXXX to
PIC18FXXXX
Source Code

Conversion Tips

PIC16C/FXXX toPIC16C/FXXX to
PIC18FXXXXPIC18FXXXX
Source CodeSource Code

Conversion TipsConversion Tips
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PIC16F/CXXX to PIC18FXXXX
Assembly Compatibility

PIC16F/CXXX to PIC18FXXXXPIC16F/CXXX to PIC18FXXXX
Assembly CompatibilityAssembly Compatibility

l C source code on most PIC16C/FXXX platforms will
directly port to PIC18FXXXX

l Compatible Assembly code source except:
l Absolute constants used for program memory
l Computed GOTO  (addwf PCL,F)
l RAM requirements above 256 bytes are selected by BSR

not RP0 and RP1 bits
l FSR is 12 bits wide, also includes auto increment

l Double check immediate constants when initializing
peripherals

l C source code on most PIC16C/FXXX platforms will
directly port to PIC18FXXXX

l Compatible Assembly code source except:
l Absolute constants used for program memory
l Computed GOTO  (addwf PCL,F)
l RAM requirements above 256 bytes are selected by BSR

not RP0 and RP1 bits
l FSR is 12 bits wide, also includes auto increment

l Double check immediate constants when initializing
peripherals
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Code Conversion TipCode Conversion TipCode Conversion Tip

l Data Memory Access
bsf  STATUS,RP0 bcf  STATUS,RP0

l These instructions can be ignored because bits 7,6,5 in
STATUS register are unused

l For devices with less than 256 bytes of RAM, it is not
necessary to be concerned with RAM locations.  Why is this
the case?

l Most memory accesses can be done in Access Bank
l Assembler will automatically select “a” bit when applicable

l Address locations now use 12-bit values.
l Set the BSR if you need to.

l Data Memory Access
bsf  STATUS,RP0 bcf  STATUS,RP0

l These instructions can be ignored because bits 7,6,5 in
STATUS register are unused

l For devices with less than 256 bytes of RAM, it is not
necessary to be concerned with RAM locations.  Why is this
the case?

l Most memory accesses can be done in Access Bank
l Assembler will automatically select “a” bit when applicable

l Address locations now use 12-bit values.
l Set the BSR if you need to.
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Code Conversion TipCode Conversion TipCode Conversion Tip

l PCLATU, PCLATH
l CALL, GOTO instructions write directly to the program

counter.
l Operations to the PC latches before a CALL or GOTO

will be ignored.

l Program addresses are now BYTE addresses
l If labels are used, then any moves to PCLATH are still

OK
l If absolute values are used, then they must be modified
l Example Goto $+1 ; PIC16CXXX

 Goto $+2 ; PIC18FXXX

l PCLATU, PCLATH
l CALL, GOTO instructions write directly to the program

counter.
l Operations to the PC latches before a CALL or GOTO

will be ignored.

l Program addresses are now BYTE addresses
l If labels are used, then any moves to PCLATH are still

OK
l If absolute values are used, then they must be modified
l Example Goto $+1 ; PIC16CXXX

 Goto $+2 ; PIC18FXXX
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Code Conversion TipCode Conversion TipCode Conversion Tip

l Conditional GOTO, Tables
Code      movlw      HIGH Table  ;(Table must be a label)
               movwf      PCLATH
               movlw      offset
               call           Table
…..
Table      addwf       PCL
               retlw         ‘A’
               retlw         ‘B’
…..

l What’s wrong with this code?

l Conditional GOTO, Tables
Code      movlw      HIGH Table  ;(Table must be a label)
               movwf      PCLATH
               movlw      offset
               call           Table
…..
Table      addwf       PCL
               retlw         ‘A’
               retlw         ‘B’
…..

l What’s wrong with this code?



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 254

Code Conversion TipCode Conversion TipCode Conversion Tip

l Conditional GOTO, Tables
Code      movlw      HIGH Table
               movwf      PCLATH
               bcf            STATUS,C
               rlncf          offset,W      ; So, multiply offset by 2
               call           Table
…..
Table      addwf       PCL             ; On PIC18, this is a BYTE address
               retlw         ‘A’
               retlw         ‘B’
…..
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Code Conversion TipCode Conversion TipCode Conversion Tip

l Be particularly careful about loading registers
movlw B’00100110’
movwf   register

l Most registers are compatible, but there are differences

l Use of symbolic bit names is safest
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Code Conversion TipCode Conversion TipCode Conversion Tip

16-bit Instruction for 16-bit Instruction for RCALLRCALL and  and BRABRA

OP CODEOP CODE

k = 11-bit Immediate Value

nn nn nn nn nn nn nn nn nn nn nn

OP CODEOP CODE ss nn
16-bit Instruction for 16-bit Instruction for CALLCALL and  and GOTOGOTO

nn nn nn nn nn nn nn

k = 20-bit Immediate Value

OP CODEOP CODE nn nn nn nn nn nn nn nn nn nn nn nn

s = 1-bit fast Save/Restore
‘FAST’ (1), (Default - 0)
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Appendix C:

PIC18FXXXX
Flash

Programming
Tips

Appendix C:Appendix C:

PIC18FXXXXPIC18FXXXX
FlashFlash

ProgrammingProgramming
TipsTips
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l READs performed on bytes
l Can READ entire user Program Memory of up to

2M plus:
l User ID locations 200000h-200007h
l CONFIG registers 300000h-30000Dh
l Device ID registers 3FFFFEh,3FFFFFh

l To READ Program Memory:
l Load TBLPTRU,TBLPTRH,TBLPTRL
l Execute one of the TBLRDs

l TBLRD*, TBLRD*+, TBLRD+*, TBLRD*-
l result in TABLAT

l READs performed on bytes
l Can READ entire user Program Memory of up to

2M plus:
l User ID locations 200000h-200007h
l CONFIG registers 300000h-30000Dh
l Device ID registers 3FFFFEh,3FFFFFh

l To READ Program Memory:
l Load TBLPTRU,TBLPTRH,TBLPTRL
l Execute one of the TBLRDs

l TBLRD*, TBLRD*+, TBLRD+*, TBLRD*-
l result in TABLAT

PIC18F FLASH
Program Memory Reads and Writes

PIC18F FLASHPIC18F FLASH
Program Memory Reads and WritesProgram Memory Reads and Writes



© 2002 Microchip Technology Incorporated. All Rights Reserved.       618 ICD               PIC18FXXX DFT Hands On Workshop                 259

l 18F Addressable Memory
is divided into:

l USER MEMORY:
l Up to 128 Kbytes

internal
l Up to 2 Mbytes external

l USER IDs:
l 8 modifiable bytes

l CONFIGs:
l Device settings, code

protects, etc
l DEVICE IDs:

l Part and rev. signature

l 18F Addressable Memory
is divided into:

l USER MEMORY:
l Up to 128 Kbytes

internal
l Up to 2 Mbytes external

l USER IDs:
l 8 modifiable bytes

l CONFIGs:
l Device settings, code

protects, etc
l DEVICE IDs:

l Part and rev. signature

200000h

200007h
User IDs

300000h

30000Dh
CONFIGs

3FFFFEh

3FFFFFh
Device IDs

USER MEMORY
0h

01FFFFh

PIC18F ARCHITECTUREPIC18F ARCHITECTUREPIC18F ARCHITECTURE
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l ERASING User memory (USER MODE):
l Performed on 64 bytes (32 words)
l Load TBLPTRU,TBLPTRH,TBLPTRL

l TBLPTR 6 LSBs are don’t cares
l Configure EECON1
l Disable interrupts
l Perform programming sequence
l Start ERASE

l Internally timed, NO CODE EXECUTION
l Re-enable interrupts

l ERASING User memory (USER MODE):
l Performed on 64 bytes (32 words)
l Load TBLPTRU,TBLPTRH,TBLPTRL

l TBLPTR 6 LSBs are don’t cares
l Configure EECON1
l Disable interrupts
l Perform programming sequence
l Start ERASE

l Internally timed, NO CODE EXECUTION
l Re-enable interrupts

TBLPTRU    TBLPTRH    TBLPTRL
Table Pointer xxxxxx

PIC18F FLASH
Program Memory Reads and Writes

PIC18F FLASHPIC18F FLASH
Program Memory Reads and WritesProgram Memory Reads and Writes
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l WRITEs to User memory (USER MODE):
l Performed on 8 bytes (4 words)
l Load TBLPTRU,TBLPTRH,TBLPTRL
l Load 8 bytes into write buffers by 8 table write instructions

l TBLWT*,TBLWT*+,TBLWT*-,TBLWT+*
l Configure EECON1
l Disable interrupts
l Perform programming sequence
l Start WRITE

l Internally timed, NO CODE EXECUTION
l Re-enable interrupts

l WRITEs to User memory (USER MODE):
l Performed on 8 bytes (4 words)
l Load TBLPTRU,TBLPTRH,TBLPTRL
ll Load 8 bytes into write buffers by Load 8 bytes into write buffers by 8 table write instructions8 table write instructions

ll TBLWT*,TBLWTTBLWT*,TBLWT*+,*+,TBLWT*-,TBLWTTBLWT*-,TBLWT+*+*
l Configure EECON1
l Disable interrupts
l Perform programming sequence
l Start WRITE

l Internally timed, NO CODE EXECUTION
l Re-enable interrupts

PIC18F FLASH
Program Memory Reads and Writes

PIC18F FLASHPIC18F FLASH
Program Memory Reads and WritesProgram Memory Reads and Writes
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l 18F Internal User Memory
is separated by:

l PANELS:
l Define internal cell

grouping boundaries
l Always 8 Kbytes

(4 Kwords)
l BLOCKS:

l Define Code Protect
boundaries

l Minimum 512 bytes
l Could be 16 Kbytes

(18F8720)

l 18F Internal User Memory
is separated by:

l PANELS:
l Define internal cell

grouping boundaries
l Always 8 Kbytes

(4 Kwords)
l BLOCKS:

l Define Code Protect
boundaries

l Minimum 512 bytes
l Could be 16 Kbytes

(18F8720)

Panel 1

Panel 2

Panel 3

Panel 4

BOOT BLOCK

Panel N

1FFh

1FFFh

3FFFh

5FFFh

7FFFh

0h

PIC18F ARCHITECTUREPIC18F ARCHITECTUREPIC18F ARCHITECTURE
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l 18F Internal User Memory Panel:
l SINGLE PANEL (8K bytes):

l 18F Internal User Memory Panel:
l SINGLE PANEL (8K bytes):

ERASE
Boundaries
(64 bytes)

2000h

WRITE
Boundary
(8 bytes)

203Fh

2040h

207Fh

3F40h

3FFFh

READ
Boundary
(1 byte)

PIC18F ARCHITECTUREPIC18F ARCHITECTUREPIC18F ARCHITECTURE
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l 18F Holding Registers:
l USER - 8 bytes for entire code memory (single-panel

programming)
l ICSP programming - 8 bytes for each panel (multi-panel use)
l Loaded by TBLWT* instruction.

l TBLWT* instruction moves contents of TABLAT to a holding
register.  The last three bits of TBLPTR determine which
holding register.  TBLPTR<20:3> are don’t cares.

l 18F Holding Registers:
l USER - 8 bytes for entire code memory (single-panel

programming)
l ICSP programming - 8 bytes for each panel (multi-panel use)
l Loaded by TBLWT* instruction.

l TBLWT* instruction moves contents of TABLAT to a holding
register.  The last three bits of TBLPTR determine which
holding register.  TBLPTR<20:3> are don’t cares.

000

TABLAT

001 010 011 100 101 110 111TBLPTR<2:0> =

Holding Registers

PIC18F ARCHITECTUREPIC18F ARCHITECTUREPIC18F ARCHITECTURE
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PIC18F ARCHITECTUREPIC18F ARCHITECTUREPIC18F ARCHITECTURE

l 18F Holding Registers (cont):
l Writes to Program Memory (details later)

l TBLPTR <20:3> determines which 8 bytes of internal user
memory Holding Registers will write to

l In example, TBLPTR could be in range of 2010h - 2017h,
and the holding registers will write same 8 bytes.

l 18F Holding Registers (cont):
l Writes to Program Memory (details later)

l TBLPTR <20:3> determines which 8 bytes of internal user
memory Holding Registers will write to

l In example, TBLPTR could be in range of 2010h - 2017h,
and the holding registers will write same 8 bytes.

000 001 010 011 100 101 110 111

TBLPTR= 2010h thru 2017h

2000h

203Fh

Holding
Registers
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PIC18F EECON1PIC18F EECON1PIC18F EECON1

EEPGD CFGS - FREE WRERR WREN WR RD
R/W-x R/W-x U-0 R/W-0 R/W-x R/W-0 R/S-0 R/S-0

bit7 6 5 4 3 2 1 bit0

bit 7: EEPGD:  FLASH Program or Data EEPROM Memory Select Bit
1 = Access Program Flash memory
0 = Access Data EEPROM memory

bit 6: CFGS:  FLASH Program/Data EE or Configuration Select bit
1 =  Access Configuration registers
0 =  Access Program Flash or Data EEPROM memory

bit 5: Unimplemented:  Read as ‘0’
bit 4: FREE:  FLASH Row Erase Enable bit

1 = Erase the program memory row addressed by TBLPTR on
next WR command (cleared on erase completion)
0 = Perform write only

EECON1 REGISTER
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EEPGD CFGS - FREE WRERR WREN WR RD
R/W-x R/W-x U-0 R/W-0 R/W-x R/W-0 R/S-0 R/S-0

bit7 6 5 4 3 2 1 bit0
bit 3: WRERR:  FLASH and EEPROM Error Flag Bit

1 = A write operation is prematurely terminated (RESET)
0 = The write operation completed
Note: When WRERR occurs, EEPGD and CFGS are not cleared.

bit 2: WREN: FLASH and EEPROM Write Enable Bit
1 =  Allows write cycles
0 =  Inhibits erases or writes to FLASH and EEPROM

bit 1: WR:  Write Control Bit
1 =  Initiates FLASH erase or write or EEPROM erase/write
0 =  The write or erase operation is complete

bit 0: RD:  Read Control Bit
1 =  Initiates an EEPROM read
0 = Does not initiate an EEPROM read

PIC18F EECON1PIC18F EECON1PIC18F EECON1
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l WRITE and ERASE of internal user memory require
six instructions as shown below:

l Makes accidental writes and erases highly improbable.
l First instruction following the WR bit set must be NOP. This

instruction was pre-fetched and must be discarded.

l WRITE and ERASE of internal user memory require
six instructions as shown below:

l Makes accidental writes and erases highly improbable.
l First instruction following the WR bit set must be NOP. This

instruction was pre-fetched and must be discarded.

movlw 55h
movwf EECON2
movlw AAh
movwf EECON2
bsf EECON1,WR
nop

movlw 55h
movwf EECON2
movlw AAh
movwf EECON2
bsf EECON1,WR
nop

PIC18F REQUIRED SEQUENCEPIC18F REQUIRED SEQUENCEPIC18F REQUIRED SEQUENCE
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l READs performed on bytes
l Can READ entire user Program Memory of up to

2M plus:
l User ID locations 200000h-200007h
l CONFIG registers 300000h-30000Dh
l Device ID registers 3FFFFEh,3FFFFFh

l To READ Program Memory:
l Load TBLPTRU,TBLPTRH,TBLPTRL
l Execute one of the TBLRDs

l TBLRD*, TBLRD*+, TBLRD+*, TBLRD*-
l result in TABLAT next instruction cycle

l READs performed on bytes
l Can READ entire user Program Memory of up to

2M plus:
l User ID locations 200000h-200007h
l CONFIG registers 300000h-30000Dh
l Device ID registers 3FFFFEh,3FFFFFh

l To READ Program Memory:
l Load TBLPTRU,TBLPTRH,TBLPTRL
l Execute one of the TBLRDs

l TBLRD*, TBLRD*+, TBLRD+*, TBLRD*-
l result in TABLAT next instruction cycle

PIC18F READPIC18F READPIC18F READ
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; Load Table Pointer
movlw   UPPER(TBL_ADDR)
movwf   TBLPTRU
movlw   HIGH(TBL_ADDR)
movwf   TBLPTRH
movlw   LOW(TBL_ADDR)
mowvf   TBLPTRL
tblrd*
movff   TABLAT,INDF0

; Load Table Pointer
movlw   UPPER(TBL_ADDR)
movwf   TBLPTRU
movlw   HIGH(TBL_ADDR)
movwf   TBLPTRH
movlw   LOW(TBL_ADDR)
mowvf   TBLPTRL
tblrd*
movff   TABLAT,INDF0

l READ Code example:l READ Code example:

PIC18F READPIC18F READPIC18F READ
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l ERASING User memory:
l Performed on 64 bytes (32 words)
l Load TBLPTRU,TBLPTRH,TBLPTRL
l Configure EECON1
l Disable interrupts
l Perform programming sequence
l Start erase (Set WR bit)

l Internally timed 2 mS (typical)
l PROCESSOR ‘HALTS’, NO CODE EXECUTION
l TBLPTR 6 LSBs are don’t cares

l Re-enable interrupts

l ERASING User memory:
l Performed on 64 bytes (32 words)
l Load TBLPTRU,TBLPTRH,TBLPTRL
l Configure EECON1
l Disable interrupts
l Perform programming sequence
l Start erase (Set WR bit)

l Internally timed 2 mS (typical)
l PROCESSOR ‘HALTS’, NO CODE EXECUTION
l TBLPTR 6 LSBs are don’t cares

l Re-enable interrupts

TBLPTRU    TBLPTRH    TBLPTRL
xxxxxx

PIC18F ERASEPIC18F ERASEPIC18F ERASE
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l ERASE User Memory Code Example:l ERASE User Memory Code Example:
; Load Table Pointer

bsf EECON1,EEPGD
bcf EECON1,CFGS
bsf EECON1,WREN
bsf EECON1,FREE
bcf INTCON,GIE
movlw 55h
movwf EECON2
movlw AAh
movwf EECON2
bsf EECON1,WR
nop
bsf INTCON,GIE
bcf EECON1,WREN

; Load Table Pointer
bsf EECON1,EEPGD
bcf EECON1,CFGS
bsf EECON1,WREN
bsf EECON1,FREE
bcf INTCON,GIE
movlw 55h
movwf EECON2
movlw AAh
movwf EECON2
bsf EECON1,WR
nop
bsf INTCON,GIE
bcf EECON1,WREN

PIC18F ERASEPIC18F ERASEPIC18F ERASE
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l WRITEs to User memory:
l Performed on 8 bytes (4 words)
l Load TBLPTRU,TBLPTRH,TBLPTRL
l Load 8 bytes into write buffers by 8 table write instructions

l TBLWT*,TBLWT*+,TBLWT*-,TBLWT+*
l Configure EECON1
l Disable interrupts
l Perform programming sequence

l WRITEs to User memory:
l Performed on 8 bytes (4 words)
l Load TBLPTRU,TBLPTRH,TBLPTRL
ll Load 8 bytes into write buffers by Load 8 bytes into write buffers by 8 table write instructions8 table write instructions

ll TBLWT*,TBLWTTBLWT*,TBLWT*+,*+,TBLWT*-,TBLWTTBLWT*-,TBLWT+*+*
l Configure EECON1
l Disable interrupts
l Perform programming sequence

PIC18F WRITEPIC18F WRITEPIC18F WRITE
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l WRITEs to User memory (cont):
l Start write (set WR bit)

l Internally timed 2 mS
l PROCESSOR ‘HALTS’, NO CODE EXECUTION
l TBLPTR 3 LSBs are don’t cares

l Re-enable interrupts

l WRITEs to User memory (cont):
l Start write (set WR bit)

l Internally timed 2 mS
l PROCESSOR ‘HALTS’, NO CODE EXECUTION
l TBLPTR 3 LSBs are don’t cares

l Re-enable interrupts

PIC18F WRITEPIC18F WRITEPIC18F WRITE

TBLPTRU    TBLPTRH    TBLPTRL
xxx
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PIC18F WRITEPIC18F WRITEPIC18F WRITE
l What’s wrong with this?

l After the last TBLWT*+,  TBLPTR would be pointing to
the next 8 bytes block !

l What’s wrong with this?

l After the last TBLWT*+,  TBLPTR would be pointing to
the next 8 bytes block !

; GIVEN:
; FSR0   -> points to first of 8 bytes of a buffer
; that will be written
; TBLPTR -> points to first byte of 8 byte block in
; internal user memory
; COUNTER = 8
; WRITEIT = Correct programming macro

WRITE_TO_HREGS
movff POSTINC0,TABLAT ; load Holding Regs

 TBLWT*+ ;
decfsz COUNTER ;
bra WRITE_TO_HREGS ;
WRITEIT ; Write Holding Regs

;  to user memory
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Appendix D:

PIC18FXXXX
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l Spreadsheet based on Microsoft Excel
l Calculates period, baud rate, operating

frequency for the following peripherals:
l TMR0,TMR1,TMR2 and TMR3 period
l PWM / CCP0 through PWM / CCP4 frequency
l A/D conversion period
l UART Baud Rate

l Contains reference map for Special Function
Registers, Pinouts and Instruction Set
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